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WELCOME Welcome to the latest issue of Advanced Photoshop. Don’t worry, it’s not missing something! If you’re wondering where the disc that used to accompany the mag has gone, it’s in the cloud… APRIL MADDEN Editor IN THIS ISSUE: DIGITAL PAINTING TYPOGRAPHY PHOTOMANIPULATION ILLUSTRATION GRAPHIC DESIGN



COVER IMAGE ANDY HAU www.andyhau.com The multi-talented artist, designer and architect Andy Hau is our cover star this issue. Join him on p52 as he explains how to create a fantastic retro-style chalkboard eﬀect using Photoshop and Illustrator.



We’ve changed the way you access the tutorial files and bonus content that comes free with the magazine, to make it easier for print and digital readers alike to download and use. You’ll now find all of your free resources on our new FileSilo site. To find out more, turn to p96. We’ve got a packed issue for you this month. Check out our 20 top tips for creating professional infographics on p28 and delve into the wonderful world of game art on p36. Learn how to design your own games character with concept artist JB Casacop on p46, and discover how to craft our beautiful cover with designer Andy Hau on p52. On p62, photomanipulation expert Brandon Cawood demonstrates how to use photos to composite a sci-fi cityscape, on p68 illustrator Mordi Levi shows you how to create a stylised low-poly portrait, and on p74, Paul Scott Canavan explains how to create a real-media paint effect in Ph
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68 LOWPOLY PORTRAITS WORKSHOP:



Create a low-poly illustration by combining Photoshop and Illustrator for pixel-perfect results



74 REAL PAINT EFFECTS WORKSHOP:



IN PHOTOSHOP



Create a fantastical digital illustration using traditional painting techniques
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PRO PANEL



MORDI LEVI



www.mordilevi.com



Learning new techniques is a wonderful way to develop, but try not to be overwhelmed by different ways to create. The technique is just a tool and it’s up to you to use it wisely. Choose one technique that you really feel a connection with and dive into it as deep as you can. Creativity is not just ideas and concepts; it’s taking something that everybody else does, and making people look at it as if it’s the first time. Make it your own. ■ Change the way you look at things with Levi’s masterclass in low-poly artwork on p74



© Mordi Levi



GET INSIDE THE MINDS OF SOME OF THE INDUSTRY’S HOTTEST TALENTS, AND DISCOVER THEIR DIGITAL ART AND RETOUCHING SECRETS



Creativity is not just ideas and concepts; it’s taking something that everybody else does, and making people look at it as if it’s the first time © Brandon Cawood



MORDI LEVI / WWW.MORDILEVI.COM



BRANDON CAWOOD



www.brandoncawood.com Always set aside time to do personal projects. Creating a personal project puts the ball in your court. It gives you the opportunity to create artwork that truly reflects the type of work you would like to be commissioned for. This image is from a personal project of mine that has been seen hundreds of thousands of times all over the world. If you can imagine it, give creating it a shot! ■ See what else Cawood can achieve with photomanipulation in his expert guide on p62
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The magazine for Adobe® Photoshop® professionals



ANDY HAU



JB CASACOP



jbcasacop.deviantart.com I’m a videogame concept artist, and I spend my downtime indulging in indie graphic novels and random encyclopaedia articles. My art is a melting pot of things I like about fantasy illustration, classical realism, and popular culture. My root idea for this was liberation, which I represented metaphorically as the act of surrendering one’s investments to uncertainty. Letting go is often a painful but necessary decision, hence the title Malungkot Ngunit (literally, ‘sad however’ in Filipino). ■ Get your game on and discover how to create first-class game art with Casacop on p46



© JB Casacop



© Andy Hau



www.andyhau.com Like most designers, I am annoyingly fussy. While Photoshop is brilliant for creating soft, ethereal effects, it is somewhat lacking in accuracy, which is why I love to combine Photoshop with Illustrator. This allows you to have beautifully clean edges and at the same time, lets you create convincing ambient effects such as lighting, which gives the image emotion. ■ Master typographic effects and learn how our cover was created in Hau’s tutorial on p52
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Disclaimer



PAUL SCOTT CANAVAN



www.paulscottcanavan.com Tell a story! When you paint a scene, try to inject as much life as you can into it by including story elements wherever you can. Ask yourself questions as you work; why are these characters here? What is this place? How is the environment reacting to them? The more there is to read into your work, the more exciting it is to the viewer! ■ Learn more about storytelling through imagery with Canavan’s tutorial on re-creating traditional paint effects in Photoshop on p68
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EYE ON DESIGN INDUSTRY NEWS



GET £315 OF GOODIES FREE WITH A WACOM CINTIQ ANYONE BUYING A CINTIQ PEN DISPLAY OR CINTIQ COMPANION GETS ANOTHER PRODUCT FOR FREE



The Cintiq 24HD in use: The Cintiq HD and HD Touch tablets are more for professional use, adding elements such as 2,048 levels of pressure and multi-touch controls
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The Intuos 4 Family line: The Intuos range of tablets, which come in a wide variety of different sizes, are aimed at home users



To redeem the free prize, Cintiq customers need to register their product at http://cintiqbonus. wacom.eu up until 31 December 2014 with a serial number, date of purchase and an image of the invoice or receipt as proof of purchase as a JPEG or PDF, and any customers who purchased a Cintiq between 15 July and 31 October will be able to choose from the six bonus items. They will then receive either a download key, or a voucher for a partner website or for the Wacom eStore. For further information on the Cintiq Bonus Programme, visit http://cintiqbonus.wacom.eu.



© Wacom



W



acom has announced that until 31 October 2014, any customers who buy a Cintiq pen display or Cintiq Companion mobile tablet can also choose to get themselves one creative product or service worth up to £315 for free – as long as they register their Cintiq at www.wacom.eu/register by 31 December 2014. First introduced by Wacom late last year to generally very positive reviews, the Cintiq Companion mobile tablet comes in both the Hybrid version at £1,000, which combines the creative pen display with an Android tablet and a quad-core NVIDIA Tegra 4, featuring 72 graphics cores and the choice of 16 or 32 GB of storage; or the £1,600 Companion, which combines the tablet with a full Windows 8 operating system, an Intel Core i-7 processor, and either a 256 or 512 GB SSD. Meanwhile, pen displays available include everything from the more compact Cintiq 13HD for £750 to the Cintiq 24HD touch, a high-end model for production at £2,500. They all benefit artists by allowing them to draw directly onto a high-definition display, where they can see their digital work, with Wacom’s pressure-sensitive pen. They are also cross-platform compatible, and have popular



© Wacom



INDUSTRY NEWS



MORE ABOUT WACOM ergonomic features such as a rotating stand and ExpressKeys for an efficient workflow. The value of the bonus items depends on the retail value of the Wacom product the customer has purchased, but would include choices such as a Wacom CarePack, hardware and software from manufacturers like Datacolor and Corel, several vouchers, and even video training courses, including: ■ Corel Painter X3 – digital painting software ■ Wacom CarePack extension – an additional year of professional protection for the Cintiq in case of hardware damage ■ Datacolor Spyder – colour-management tools to bring accurate colour for products and images through monitor colour calibration ■ Video to Brain training courses – a bonus for training videos to improve creative skills and enhance creative workflow from video2brain or lynda.com ■ CEWE voucher – a voucher to print photos, sketches or drawings to be able to meet urgent production timelines ■ Tecco voucher – a voucher for high-quality printing in contract-rich and exhibition quality using different types of printing media



Founded in Japan in 1983, Wacom is a global company with offices around the world supporting marketing and distribution in over 150 countries. Wacom’s products have been used by artists to create everything from digital art, films, and special effects to fashion and product designs, with the company retaining a reported 92.3 per cent of the market share in Japan for 2013. Tablets include the Intuos tablets, formerly known as Bamboo tablets and aimed at home users. These feature 1,024 levels of pressure sensitivity and a resolution of 1000 lines/cm, with wireless capabilities for connecting to a computer. The Intuos Pro line is marketed at graphic artists and has more capabilities, with multiple sizes, 2,048 levels of pressure, and 50-60 degrees of tilt sensitivity according to the size of the tablet. Users can also manipulate the canvas using multi-touch gestures. The Cintiq 13HD, 22/24 HD, and 22/24HD Touch add another dimension by allowing artists to draw directly onto the screen of the tablet, creating a feel much more like drawing on a piece of paper. These tablets also include 2,048 levels of pressure sensitivity for both the pen tip and eraser, and a tilt range of up to 40 degrees.



THE NEW STOCK IMAGE SITE IS ESTIMATED TO PASS THE 100,000 MARK BY THE END OF 2014



Months after being acquired by Pluralsight to offer a new combination of 3,000 courses for training IT administrators, software developers and creative professionals alike, Digital-Tutors has announced the launch of professional front-end web and interactive tutorials covering web design, UX, HTML, CSS, Edge Animate, Flash, WordPress and more. The first 15 web tutorials have now been released, with more than 30 in production for the near future. Aimed at giving artists a new way to learn to make web and interactive content, according to Digital-Tutors the new web training is helping to meet the need for companies as well as design professionals looking to create seamless, memorable web experiences and a better online presence. “The convergence of media and technology is being pushed to incredible new heights every day,” The acquisition of Digital-Tutors doubled Pluralsight’s courses from 1,500 to 3,000 earlier in 2014. For more information visit Pluralsight.com or Digitaltutors.com



“Digital-Tutors’ creative training prowess and the ability to tie in Pluralsight’s development and IT training with this new front-end training gives companies and artists a one-stop destination for creating engaging, highly-functional websites, platforms and interactive media,” said Pluralsight CEO Aaron Skonnard.



said Piyush Patel, founder of Digital-Tutors and chief innovation officer for Pluralsight. “The web is the channel where it’s happening and it’s key for the creatives, the front-end web teams and the back-end tech world to look at the whole picture – from creating the media content itself, to then creating the web experience and back-end systems that seamlessly deliver it.” “Our new web design courses offer a powerful merger of creative and technical training content,” added Pluralsight CEO Aaron Skonnard. The company is now the world’s largest curated e-learning library for professionals, with customers in more than 150 countries. These courses are helping the team deliver both front-end and back-end web training for the first time.



Dollar Photo Club has had worldwide success since it first launched in February, with the firm now revealing it expects to pass the 100,000 member mark by the end of 2014. The stock image site, which currently boasts 40,000 members, offers its users the ability to download images for a basic $1 each, with several options to sign up to, such as a $10 a month membership for 10 images or a $99 yearly membership for 99 images. Featuring 27 million royalty-free images to choose from and accessibility in 13 languages, it is one of the largest collections in the world – though of course with European stock leader Fotolia as a parent company, this achievement is hardly surprising. “Dollar Photo Club provides an affordable avenue to those who wish to access the right resources while staying within legal boundaries,” explained the company in a statement. “They also understand that these unique value propositions will address the currently difficult-to-understand licensing issues worldwide. Finally, an image bank exists that appreciates the fact that it is not about telling clients what to do with licensing, but rather listening to clients and building something time-efficient and easy to use for them.” Overall, the aim of the site will be to have more and more Photoshop users, as well as any other artists and multimedia professionals around the world, come straight to the Dollar Photo Club as opposed to deciding to download imagery through illegal means.



© Dollar Photo Club



THE ONLINE CREATIVE TRAINING SITE OFFERS USERS NEW WEB AND INTERACTIVE TUTORIALS



DOLLAR PHOTO CLUB GAINS 40,000 MEMBERS



See more at www. dollarphotoclub. com, www. facebook.com/ DollarPhotoClub or on Twitter at www.twitter.com/ dollarphotoclub



© Dollar Photo Club



DIGITALTUTORS LAUNCHES NEW TRAINING COURSES
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COMPETITION CREATE THE COVER OF ADVANCED PHOTOSHOP



CREATE THE COVER OF ADVANCED PHOTOSHOP ENTER OUR COMPETITION AND YOU COULD WIN A COMMISSION FROM ADVANCED PHOTOSHOP AND SEE YOUR ARTWORK ON THE COVER OF THE MAGAZINE!



e’d like to see what you can do with our cover. That’s why we’re challenging you to produce a piece of cover artwork for Advanced Photoshop. We’ll feature the best in an upcoming issue of the magazine, and our favourite will win a paid commission to create a tutorial explaining how their artwork was created. To enter, all you have to do is produce a piece of fantastic Photoshop artwork. But before you get started, you’ll need to bear in mind the following:



W



you a line to ask for the high-res artwork. ■ Your artwork must be an original piece that you haven’t submitted to any other magazine. ■ Your artwork cannot include nudity or fan art of copyrighted characters. ■ You’ll need to leave room for us to include the title of the magazine, its barcode, and some text to explain what’s in the issue. ■ Make sure it is attention-grabbing and has a strong focal point!



■ Your artwork can be in any style you choose. It could be photomanipulation, graphic design, digital painting or illustration. ■ Your artwork should be 240mm wide by 310mm high at 300 dpi. But please send us a low-res JPEG first – if you make it into the final selection, we’ll drop



To enter, simply send your artwork to [email protected] with the subject line ‘Cover competition’. Please include your name, full address and contact details with your entry. The deadline for competition entries is 27 November 2014.



TERMS AND CONDITIONS Imagine Publishing has the right to substitute the prize for a similar item of equal or higher value. Employees of Imagine Publishing, their relatives or any agents are not eligible to enter. The editor’s decision is final and no correspondence will be entered into. The prize is a paid commission from Imagine Publishing, paid via our standard invoicing process. The prize cannot be exchanged for cash. Unfortunately, we are unable to open this competition to readers based in Brazil. From time to time, Imagine Publishing or its agents may send you related material or special offers. If you do not wish to receive this, please state clearly on your entry.
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EYE ON DESIGN PORTFOLIO INTERVIEW



PORTFOLIO INTERVIEW



Derek Stenning www.borninconcrete.com



MASTERFUL CONCEPTS



PROFESSIONAL ANIMATOR DEREK STENNING TELLS US WHAT IT’S LIKE TO WORK IN THE FILM AND GAMES INDUSTRY



B



eing successful in your chosen industry – or making it big, as they say – is no mean feat, especially in the cut-throat world of concept art. Derek Stenning has not only successfully navigated his way into the film and games industry, but has also created an impressive portfolio working for some of the top organisations, including Marvel and Microsoft to name but a few. Stenning believes that there is a common illustrated quality to his images that not only keeps his work unified, but also seemingly keeps the commissions coming in thick and fast. WHAT HAS BEEN THE DRIVING FORCE BEHIND YOUR EVEREVOLVING WORK? I have a desire to create and my outlet is producing art in the form of 2D illustrations and designs. I don’t EK_20 A.R.A.R.I.T.A.: This is a piece



© Derek Stenning



from my personal series Enartete Kunst (The EK Series)
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really have a choice in the matter, I have to create art. When I am regularly producing art, all is well in my world. When I get too busy with other things, I can’t follow this desire to an acceptable extent, so I get grumpy and life becomes work. It is that desire that pushes me in both my professional and personal work. TELL US A LITTLE MORE ABOUT YOUR HISTORY AS AN ARTIST… I enjoyed creating art when I was young, but I didn’t take it seriously until I decided to leave university to study animation at Capilano College. Since then I have never looked back. I started working at an animation studio in the design department right out of college, then made the move over to the game industry soon after. Over the years I’ve done concept,



promotional, and various other art-related tasks on projects for Nintendo, Microsoft, Activision and other publishers. Recently I returned to creating my own personal work, and I had my first book published last fall. HOW DID YOU ORIGINALLY GET INTO CONCEPT ART, AND SPECIFICALLY THE FILM AND GAMES INDUSTRY? When I left school I started working at an animation studio in Vancouver. The work there was uninspiring and pretty cookie cutter, so after about a year I was tired of it. Then a friend of mine from school called me and asked if I wanted to come work for a game studio in Iceland, so I figured, why not? I moved to Reykjavík and started working on modelling and concept art. I found that the work in games had



EK_22 Dystopic (ventilate): Also from



my personal series Enartete Kunst. This piece was the basis of a 1/6th scale resin model kit produced by Industria Mechanika. Check it out at industriamechanika.com



A Lifetime Of Silence Behind The Green Door:



© Derek Stenning



© Derek Stenning



This image was created for Endeavor Snowboards as part of a line of board graphics based on the book I Could Tell You But Then You Would Have To Be Destroyed by Me by Trevor Paglan



WHAT HAS BEEN YOUR GREATEST LEARNING CURVE THROUGHOUT YOUR CAREER? The longest, most drawn-out curve in my development has been transferring to digital media and digital painting. When I was younger, my primary medium was drawing and studying classical 2D animation. When I switched over to games, I started using digital media, and it took me a long time to get comfortable with it. On top of that, switching from a drawing mindset to a painting mindset is also something that I continue to battle with. Changing from a tablet to a Cintiq has helped, but I think I have a long way to go. TELL US ABOUT YOUR FIRST BOOK  HOW DID THAT COME ABOUT? Several years ago I started working on personal work again, focusing on a body of work called Enartete Kunst, or the EK Series. This work gained some exposure through being featured in various publications and art shows. One day, Scott Robertson from Design Studio Press contacted me and asked if I would like to put it all together in a book. They put out some great books, so I was very excited to work with them.



EK_29 Insolent Mockery Of The Divine Under Centrist Rule: This one was a favourite of mine from the EK Series. It was one of those pieces that just came together



Airhole: MBU-12, Airhole: KM-34D: These pieces were created as graphics for Airhole ski and snowboard face masks. They were only produced once and have long since sold out, but I still get the occasional email from people looking for them EK_28 The Star



(Emperor): These personal pieces, and many more like them, are available in the book; Born In Concrete: The EK Series, published by Design Studio Press



As a professional, you have to find an aspect of a commission that you find interesting or that inspires you 014



© Derek Stenning



WHAT ABOUT YOUR WORK WITH NINTENDO AND XBOX? I’ve created concept art for several Nintendo titles, all through Next Level Games, a great developer in Vancouver. They are a lot of fun to work with and since they are handling top-tier Nintendo IP, you get the time and resources to do good work and make a great product. As for Microsoft, I was doing concept art and ideation for a studio working on new technologies.



© Derek Stenning



YOU CLASS YOURSELF AS A CONCEPT ANIMATOR  WHAT WOULD YOU SAY IS YOUR FAVOURITE ASPECT OF THE INDUSTRY? In a production sense, concept art is a very open and creative role. You are the first one to dive into visualising different aspects of the game. You aren’t working from a guide or design bible, you are creating that guide or design bible. So even though you are working within the confines of the genre, the setting, and the story, you have a lot of freedom to establish the visual direction, and that is often a very fun process.



Ruined Youth:



Ruined Youth was created as part of line of board graphics for Endeavor Snowboards titled Vory V Zakone (Thieves In Law). It was based on the culture and meaning of Russian prison tattoos



© Derek Stenning/Airhole



more depth and was more fun, so other than the occasional illustration side project, I’ve largely stayed with games.



© Derek Stenning



EYE ON DESIGN PORTFOLIO INTERVIEW



© Next Level Games



Gremlin Leadship Types, Herman and Otto: These are two of the characters created to help flesh out a design pitch for a game titled Clockwerk for Next Level Games



© Derek Stenning



EYE ON DESIGN PORTFOLIO INTERVIEW



On the surface their work has a detail and technical mastery that I find very inspiring and leaves me in awe, but behind this there is also depth and substance The first year there was really good and we were working on exciting projects. But unfortunately, over time the direction of the program we were tied to changed significantly, and I wasn’t enjoying the work anymore, so I left Microsoft late last year. WHO WOULD YOU SAY INFLUENCED OR STILL INFLUENCES YOUR WORK? I’m still largely influenced by the artists that really struck me when I was younger, the artists that helped me choose this path: Alphonse Mucha, H.R. Giger, Frank Frazetta, and the film work of Hayao Miyazaki, Katsuhiro Otomo, and Mamoru Oshii. There is a magic to the creations of these artists. On the surface, their work has a detail and technical



PORTFOLIO TIPS



STENNING GIVES US HIS ADVICE ON HOW TO BUILD A SUCCESSFUL AND VARIED PORTFOLIO



■ DO IT YOUR WAY Try to follow your own interests and inspiration when it comes to creating. I’ve always had the most success – and the most fun – when I’ve followed my own instincts, looked within and created the work that I wanted to. It may be hard to find inspiration at first, but the results will be more unique and rewarding. ■ RESEARCH! A little research into the subject of your next commission will go a long way. It will give you a greater understanding and appreciation of the design at hand and can spark new ideas or design solutions. The knowledge will allow you to bring more substance and meaning to your designs. ■ BEST FOOT FORWARD When putting a portfolio together, only include your best work. If you think to yourself ‘I am not sure if this is good enough to go in my portfolio’, then it probably isn’t, so leave it out.
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mastery that I find very inspiring and leaves me in awe, but behind this there is also depth and substance that I find equally compelling. WHAT IS THE MOST CHALLENGING PART OF CREATING A COMMERCIAL IMAGE? For me the hardest part is keeping the excitement and interest level up. When working on personal pieces, you can freely follow your own interests and inspirations and that is really satisfying. But with commercial work you are designing to someone else’s criteria, or someone else’s vision, and that usually doesn’t fully align with your own. So as a professional, you have to find an aspect of a commission that you find interesting or that inspires you, really sink your teeth into it and let that carry you through the work. WHAT ROLE DOES PHOTOSHOP PLAY IN YOUR WORK? Photoshop plays a very large role in my work. Over the years I’ve moved to complete digital production and now almost all of my work is created in Photoshop from start to finish. From initial planning, to sketching, to painting, it is all done in Photoshop. Sometimes I’ll incorporate 3D elements to use as a basis for an environment concept, vector elements for graphics, or logos, but it all finds its way into Photoshop in the end. WHAT KIND OF TOOLS DO YOU USE ON A REGULAR BASIS WHEN DIGITAL PAINTING? I have a small selection of brushes and tools that I use regularly for the core of my painting. These are



CYOA_03:



Created for a Wired magazine article on the Choose Your Own Adventure series of books. I loved those books as a kid so this one was a lot of fun



relatively simple brushes and tools (angled brush, cloud brush, softer edged brush, all with various dynamics and opacity settings) that I have collected over the years and I use them for about 90% of the painting that I do. I also create special-use brushes for individual projects or pieces – brushes that help me achieve a certain look or feel. The adjustment tools (Levels, Hue/Saturation) are also great and have saved me on more than one occasion! WHAT’S NEXT FOR YOU? WHAT ARE YOU WORKING ON? I’m currently working on concept art for a new title with Next Level/Nintendo. I’m also doing some more work for Tiny Mob Games/Tiny Realms, as well as illustrating some novel covers. On the personal front I have three more model kits coming out, based on figures from the EK Series and produced by Industria Mechanika, the first of which is to be released in the fall. I’ll also be releasing some T-shirts, and most importantly I’m going to be getting a new personal project off the ground.



cgi illustration by sanders.shiers
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ALTERNATIVE ADVERTISING BRENTBLACK STUDIO’S BRENT SWART REVEALS HOW HE CREATED A NEW STYLE CONCEPT FOR STREET ADS



W ABOUT THE ARTIST BRENT SWART www.brentblack.co.za



Illustrator and designer Brent Swart is heavily inﬂuenced by designer toys, tattoo art and the alternative music scene. He studied graphic design and majored in visual communication and alternative advertising.



NAME OF PROJECT THE THIRSTY OCTOPUS



The preliminary sketch
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ith a distinctive, vibrant style and an extensive portfolio of eye-catching illustrations, Brent Swart – who heads Pretoria-based design crew, BrentBlack Studio – is certainly making a name for himself. After opening its doors in 2011, the studio has grown to become a solid brand associated with Pretoria’s gritty alternative scene, focusing heavily on illustration and poster design. It has worked with a range of clients including Converse Cons, Arcade Empire Pretoria, Park Acoustics/Jack Daniel’s and Capital Craft Beer Academy. Despite the successes, however, Swart is still very humble. An avid doodler, he explains he loves nothing more than a good pencil, zombie movies and a coffee. As for BrentBlack Studio, he maintains it was working together with others – networking and collaborating with great businesses and people – that really got the team to where they are today. To find out more about how he did it, we asked Swart about the studio’s latest project, a Sprite pitch called ‘The Thirsty Octopus’. CAN YOU TELL US MORE ABOUT YOURSELF, AND HOW YOU FIRST BECAME AN ILLUSTRATOR AND USED PHOTOSHOP? I started my design journey back in high school. When the school I attended did not have art, I took it upon myself to draw on any surface I found. I later took a gap year or two and dabbled in tattoo art and



2D development



silk screening for shirts, before studying graphic design in my early twenties, which opened up a whole new world for me. HOW WERE YOU FIRST APPROACHED TO CREATE THE SPRITE PITCH? I am currently directing art at an outdoor advertising agency called Wideopen Platform, and was asked to come up with a creative way to portray Sprite in Johannesburg’s urban street environment. HOW WAS THE IDEA OF YOUR THIRSTY OCTOPUS FIRST DEVELOPED? WHY DID YOU FEEL THIS WOULD BE A GREAT AD? Johannesburg is in the centre of South Africa, so very away from any beaches. I wanted to use this fact to show the uniqueness of a Sprite consumer: the guy who sticks out. I wanted the ideal consumer to represent someone you won’t see everyday, like an octopus in central Johannesburg. CAN YOU GIVE US A BRIEF DESCRIPTION OF THE WORKFLOW FOR THE FINAL 3D BILLBOARDSTYLE PIECE? I worked with two very talented 3D artists, Rofhiwa Nyambeni and Hugo Perdiz, to create the piece. Together we moulded each tentacle to create depth and shading, and each arm was rigged in 3D and carefully placed into the design to mimic the 2D artwork. It’s always a challenge to bring a two-



3D concept



dimensional image into a 3D space without it looking strange, but with careful planning we brought it to life. We wanted to create an outdoor design that would work in any environment, so we made backdrops that duplicated the building’s look and feel, to give it an extra dimension. To use an amalgamation of 2D and 3D was a simple decision: 2D was used to represent the street art that can be found in and around Johannesburg, while the 3D was used to make the viewer look twice and truly notice the outdoor advert. WHAT PHOTOSHOP TOOLS AND TECHNIQUES DID YOU MAINLY USE TO CREATE THE FULLY 2D ILLUSTRATION? Mostly flat brushes, with a drawing tablet’s pressure function. I also love burning and dodging certain areas of the work for highlights and shadows.



All images © Brent Black



WITH SUCH AMAZING CHARACTERS UNDER YOUR BELT, WHAT ADVICE WOULD YOU GIVE FOR CREATING EYECATCHING DESIGNS? Don’t be afraid of trying new colour palettes. I tried not to use black in any of my illustrations for three months once, just to see if I would be able to. The best thing to do is practise and test yourself constantly. I also normally do a lot of collaborations with other artists, which I think is a great way to learn new techniques. Always remember to never see a fellow illustrator as your competition. Don’t hate – collate.



Progression



Always remember to name your layers in Photoshop. Otherwise, things get complicated very quickly if you’re lazy.



Before getting into Photoshop at all, start on paper. Having a guideline on how things will look will make the project easier.



Don’t be afraid to play with your hue and saturation. It may already look perfect, but you never know – you might find a better colour combination if you experiment.



SO, WHAT OTHER ARTISTS ARE THERE THAT YOU WOULD SAY YOU LOOK UP TO AND ADMIRE? Plenty, mostly local artists that have put South Africa on the map, like Louis Minnaar, Kronk and the guys at Am I Collective. I also really admire international heroes like Jon Burgerman, Buff Monster and DeeDeeKid.



CAN YOU TELL US MORE ABOUT WHERE YOU AIM TO BE IN THE FUTURE? WHERE WOULD YOU LIKE TO BE IN FIVE YEAR’S TIME? I am very happy where I am now, but I would definitely like to do more creative work for big companies in the future. I have hundreds of ideas and nowhere to put them, particularly for outdoor media. I would also like to start an illustration house in Johannesburg, where illustrators can get together and collaborate to create crazy stuff.



Imagining the ad
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STUDIO INTERVIEW



THE TEAM



COLLABORATION IS THE NAME OF THE GAME AT THE TEAM BRAND AND COMMUNICATIONS AGENCY, PROVIDING CREATIVITY AND PHOTOSHOP SKILL TO BUSINESS CLIENTS



T



he secret of success for any design studio is in collaboration, pulling together as a team to deliver high-end results. For a company called The Team, the expectations are certainly set high when it comes to a strong teamwork ethos – it’s in the name after all. Managing director Kevin MacKenzie explains how The Team works as, well, a team, both internally as well as in its liaisons with clients: “Simply put, it’s about our ethos in business. We pull together toward a common goal, to realise an idea or simply effect change. In practice, this means that we work collaboratively with our clients, colleagues and partners to come up with a collective ‘done with’ answer to the communications challenges that we are engaged to solve. Co-creation is in our DNA, and we find this way of working allows clients to actively participate in the design process of projects; of shaping their ideas, beliefs and vision in a way that is participative and engaging. We believe that the big idea is already with the client, and as a team we act as a creative catalyst to help define it and make that idea a working reality.” For the studio, the client is a key member of its team when working on projects and campaigns. While it’s all about being creative, it’s important to remember that the businesses that hire The Team have their own customers to think about as well. “Learn to walk a mile in your clients’ customers’ shoes – it’s all about the customer. Lots of people forget that,” says MacKenzie. The Team’s roots go back to 1982, when it started out as a graphic design company, but it has moved on to work with some notable names: “Over the last 30 years, we have been helping clients and have developed our portfolio of services, producing effective, award-winning brand and communication work in branding and marcomms, employee engagement, digital and publishing,” explains Kevin MacKenzie. “We have worked in a variety of sectors including financial services, charity, education and health, and our clients range from M&S to BP, English Heritage and Gas Safe Register.” These days, the studio does a lot of work on ‘employee engagement’, which business development director Paul D’Wit describes as “[bringing] the brand alive on the inside. We help our clients to connect their people, brand and strategy, creating the environment for employees and the organisation to succeed.” This kind of internal



020



We believe that the big idea is already with the client, and as a team we act as a creative catalyst to help define it and make that idea a working reality



ABOUT THE STUDIO THE TEAM www.theteam.co.uk @theteam



Ryan Miller Creative Lead



Shane Lowes Artworker



Kardo Ayoub Senior Digital Designer



Kevin MacKenzie Managing Director



Paul D’Wit Business Development Director Studio space: The studio is open plan and encourages the team to work together



All images© The Team 2014



“We’re an agency that believes in helping other businesses bring their purpose to life. We do this by serving up some amazing ideas that follow our three-stage process: discover, deﬁne and design.”
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EYE ON DESIGN STUDIO INTERVIEW



The design team: The design team working together in their creative space



Revamp: The studio space has recently been revamped to reflect the nature of the business better



communications is an area that is easy to overlook when it comes to the design industry, but it is absolutely key to the economy, encouraging people to do well at work and support the businesses that they work for. This is achieved through creative communications, designed to excite and engage. The Team has worked on a whole host of creative endeavours as part of this, as D’Wit continues: “Work ranges from the production of large, experiential installations (Heathrow Terminal 2) through to highly creative video and animations used to explain complex information (British Gas Employee Benefits
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Hard at work: Working on branding and communications projects



programme), and physical toolkits that have a host of printed and digital materials to educate, enthuse and inspire colleagues around the world (BP and FWD Insurance).” These large-scale projects certainly present the design team with some challenges, not least having to think about what the aim of the project is, what the desired effect is and who it is targeted towards. “One of the most challenging projects The Team has embarked upon over the past few years is helping to rebuild pride within BP through their ‘values and behaviours’ internal comms programmes,” says



creative lead Ryan Miller. “A challenge isn’t overcome or resolved by one singular moment or deliverable, but is something that is threaded throughout every project and communication touch point that we deliver for BP.” Sometimes, the commissions that The Team is engaged to work on have an even bigger impact, especially when it comes to the sensitive rebranding of large organisations and charities. “One of the projects that I’ve most enjoyed is also one of the most significant ones The Team has delivered within the charity sector – that of the rebranding for



CHARLES RIVER ASSOCIATES



SEE HOW THE TEAM CREATED THIS VISUAL USING HANDMADE 3D MODELS



01



3D MODELS



Here you can see a selection of 3D handmade models, ready to build our large-scale Charles River Associates installation.



04
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THE BUILD



The team are building the installation on-site in the photographic studio using 3D handmade models and invisible wire.



RETOUCHING The retouching and final photography edits at The Team studio.
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SCATTERPROOF



A scatterproof print sheet to check colour balance and background colour consistency.



FINAL Here is the final retouched image for Charles River Associates.
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EYE ON DESIGN STUDIO INTERVIEW



Parkinsons UK,” says Miller. “The collaborative journey between agency and client is one that resulted in a brand that anyone touched by Parkinson’s in the UK is proud to stand behind.” In order to create effective communications, the studio team uses a mix of creative software (including Photoshop, Illustrator and InDesign) and business packages (PowerPoint, KeyNote and Microsoft Office), which reflects the two sides to the studio’s purpose. Photoshop is an incredibly important part of the process of any project, says artworker Shane Lowes: “It’s very rare that Photoshop does not make an appearance during the production of work for clients; whether it’s retouching images from photo shoots and for websites, to smaller projects such as creating assets for applications in Word and PowerPoint, or knocking up scamps (mock-ups) for clients to envisage the potential end result. I often use Photoshop’s workflow enhancements, which create Actions and Droplets to streamline time-consuming tasks.” Working with photography on a regular basis means that one of the essential tools used in Photoshop is Camera Raw. “Editing in Camera Raw is a particularly useful and powerful addition to the software. It gives you the option to save the RAW file as a Smart Object, allowing you to fine-tune your adjustments throughout the job,” shares Lowes. He is also a fan of Photoshop’s layer editing and enhancement tools: “Another little gem is the Gradient Map adjustment layer, which we use on a



It’s very rare that Photoshop does not make an appearance during the production of work for clients



The designers: Two of The Team’s designers hard at work on various client projects



lot of projects, whether for editing tone or tint, or completely re-colouring elements – it gives you a great deal of control over detail.” The studio itself is based in central London, near the river and just around the corner from Borough Market. It has recently undergone a revamp to better reflect the nature of its work and to encourage the collaborative efforts that make The Team stand out. “We recently reconfigured a lot of our agency space to better reflect the open, inviting and collaborative nature in which we naturally work,” says Ryan Miller. “More open plan with dedicated project spaces, we actively encourage clients to feel comfortable working alongside us. Even restructuring our reception area to be centred around a communal ‘welcome’ table.” The studio space helps the team to work together by design and it encourages a



welcoming atmosphere. It is these factors that help the studio stand out from its peers, says Kevin Mackenzie: “Thinking, teamwork, hard work and trust. And don’t forget the fun factor. Most studios will be broadly the same – it’s the culture that makes the difference.” With a dedicated team that is proud of the studio and the work that it produces, it can surely only be onward and upward for The Team: “The studio is core to the product of this business. Great ideas, brilliantly executed through creative that’s practical to deploy. That means our studio needs to always be raising the bar on the quality of creative thinking and creative execution. To do that you need to be innovative, which means that we need to constantly find different and better ways of thinking and sharing our ideas to excite and inspire our clients.”



A DAY IN THE LIFE OF KARDO AYOUB



SENIOR DIGITAL DESIGNER TAKES US THROUGH A TYPICAL DAY AT THE TEAM



08:50



MORNING ROUTINE



I arrive around 8:50am and set up my laptop. I head to the kitchen and make myself a cup of coffee and some breakfast. I walk around the office and catch up with my colleagues. I check my emails and calendar to see what the plan is for the day.
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09:30



MEETING



I have my first meeting of the day around the creative tables with a project manager and the rest of the digital team to discuss the progress of our current project with English Heritage. We are redesigning the customer experience for its online and digital platforms.



10:00



BRAINSTORMING



As a group we begin brainstorming ideas for the next stage. I carry out further research at my desk, and begin sketching and storyboarding. It’s important to concept new ideas, as it gives you a feel for the end result and whether or not it’s the right solution for the brief.



Our studio needs to always be raising the bar on the quality of creative thinking and creative execution



Teamwork: Working together as a team creates strong and creative communications



Reception area: The reception area has been recently redesigned to centre around a communal ‘welcome’ table



TOP 5 PRODUCTION TIPS



Shane Lowes shares with us his top tips for seamless production



■ ALWAYS LABEL YOUR LAYERS This is good practice for you and your colleagues to help navigate those documents with hundreds of layers – it’s amazing how quickly they mount up. ■ IF POSSIBLE, USE A GRAPHICS TABLET AND PEN Unfortunately, you can’t achieve the intuitive response of the graphics tablet and pen with a mouse. This is especially the case when using pressure sensitivity and the other pen-only options within Photoshop’s brush palette. ■ USE MASKS, NOT THE ERASER TOOL Once you’ve used the Eraser tool, that information is gone. Using masks gives you the option to bring back that information throughout the job if necessary. ■ FIGHT YOUR CORNER If you don’t think that what you’ve been told to do is correct, say so, but be positive, explain your reasoning and make sure your solution is better.



All images: © The Team 2014



■ NEVER SETTLE FOR MEDIOCRITY Try to learn something new every week. Keep notes if that’s easier for you, but ensure you’re constantly learning. Sharing information and skills within the team builds both camaraderie and your profile.



12:30



LUNCHTIME



I pop out to Borough Market and grab myself some food from one of the stalls. I head back to my desk to eat my lunch and browse the internet to see what’s happening in the creative world. I have a few favourite creative and tech blogs I regularly read.



15:15



CATCH UP



I have a quick check-in with one of my project co-workers to see where he’s at with concepts. As a designer you have to organise your time well, as you will often have to schedule in catch-ups that should last only 5-10 minutes, but can run over.



18:00



&).%ɎTUNING



I’m back at my desk, so I have a quick check on my emails before it’s back to work. I am now fine-tuning my concepts ready for the next day’s meeting. [At the end of the day, 6pm] I save the work and file it ready for the next day to present to my team.
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TECHNIQUES INFOGRAPHIC ANSWERS
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WER



OIS BE W N D ES , THE FLOURISHE ALSO GIVE SUPPLEMENTS A NEW LEASE OF LIFE. DISCOVER 20 PRO TIPS FOR IMPROVING YOURS TODAY



KEEP IT SIMPLE



MICHAEL PAUKNER EXPLAINS THE THOUGHT PROCESS BEHIND THIS CLEAN INFOGRAPHIC Define your terms Paukner (www.substudio.com) gave himself the brief to depict the Earth’s oldest trees and their location in an appealing infographic. It gives just three facts: name, age and location of the Earth’s oldest trees.



At first glance “The list has a shape of a tree and the background is green – this gives an idea of the infographic’s topic at first glance. The oldest trees are at the top of the list and the younger ones at the bottom.”



Ease of interpretation “The challenge was to create a balanced composition for a text list that has the shape of a tree. Of course, it’s not always easy to follow the name back to the world map, but on the other hand, you can definitely see a bigger amount of old trees in the area of California, where most of the oldest trees are located.”



Bold choices “To give the connection lines a better balance, I decided to switch positions of west and east, showing the American continent on the right hand side.”



Small story, big picture “I made this infographic for my personal project called ‘See The Bigger Picture Album’ on Flickr, a series of 100 posters including topics like nature, geometry, science and fringe science. It has had more than 250,000 views.”
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© 2014 Michael Paukner, substudio.com



Simple style “I just used two shades of green and white. As it‘s a scientific infographic, I wanted it to look like one [by making it] very minimalistic.”



KNOW YOUR STORY
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“There are so many poor infographics out there, and often it’s down to a lack of thought about content,” explains Caroline Beavon (http://carolinebeavon. com), who was a journalist for 12 years before teaching herself design. “It’s not enough to make the



infographic look good, because the reader will very quickly realise it’s not actually saying anything. This is where some graphic designers struggle to make infographics as there’s actually a large part of the job that involves looking for a story and editing content. Good content is well researched and insightful but also needs to be structured: what will you tell the reader first? What’s the punchline? Is there a big ‘reveal’? In the same way a journalist structures an article, so an infographic needs to make logical sense. “Most clients approach me with a definite idea of what they want, and that’s great. When I have had enquiries of a more general nature, I advise them to think carefully about what it is they want to say first, as with any marketing campaign. You wouldn’t send out a press release with no real story, and it’s the same with an infographic. Most of my clients already have their information collated, as I tend to specialise in infographic reports. There are other times when a client knows what they want, but isn’t sure what information is needed, so I give them some guidance on the data to gather and we work through it together.”



DON’T UNDERESTIMATE INFOGRAPHICS “Compelling infographics provide ‘a-ha’ moments,” says Graham Roberts (www.grahaphics.com), who is a senior editor in graphics at The New York Times. “Through visual language, they reveal something that could otherwise have not been seen and understood as clearly, or at all. They should be engaging, reveal patterns, show relationships, and they should speed comprehension.” His most challenging project to do was a piece of motion graphics on the subject of conducting, called ‘Connecting Music and Gesture’. “Most infographic projects have very concrete elements to communicate,” he explains, “ or this action had this or that consequence. Conducting doesn fit into this framework at all. We know it matters tremendously, but it’s hard to explain why. We used motion capture of renowned conductor Alan Gilbe to visualise his movements. In the end, what made this piece work was pairing this visualisation of movement — in which we make visible the invisible — with an eloquent interview given by Gilbert himself. Then, we allow the reader to absorb these things together and not try to force relationships in the t infographic sense.”



Roberts’ advice for creatives interested in getting into infographics is simple: “Read books by Edward Tufte. Read The Functional Art by Alberto Cairo. Don’t fear code. Understand that making a big number next to an icon is not really making an infographic. The point is to show something to the reader that they could only really understand through a visual display of that information. It’s not just adding design to something that could just as easily have been understood through reading the same information.” See http://skl.sh/19IXPab and http://skl. sh/18oPR4W for more of Roberts’ advice.
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BLENDER CREATION



“This infographic was to be about the radiation emitted by cellphones and regular household appliances. The data came in the form of a few scientific journals on electromagnetic radiation and frequency charts. It was meant to be displayed alongside the article, where some of the figures were explained in detail so as to not overcrowd the illustration with callouts.”
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PULLING THE DATA OUT



“The data was in PDF and Excel files. The appliances were modelled in SketchUp and rendered using SU Podium. Output images were stylised in Photoshop, and all the elements eventually put together in Illustrator.”
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CHRZASTEK’S WORKSPACE



“An infographic must obviously be visually appealing, but there needs to be a lot of thought put into the selection of data and the way in which it will be represented. Lately, it seems the internet has got overly saturated with countless so-called infographics that are nothing more than cutesy illustrations of randomly selected numbers/facts...”
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TECHNIQUES INFOGRAPHIC ANSWERS



JOURNALISTIC PRINCIPLES



SUBJECT MATTER CAN VARY WIDELY IN THE SOUTH CHINA MORNING POST, BUT ADOLFO !22!.:…3ď˴,!3/-"2!",/'3#/-˵ď#,%!2 ď#/-0%,,).'ď!002/!#(ď2%-!).3ď4(%ď3!-% 001 Idea to concept



001



“in the South China Morning Post, the editor often has a preconceived concept, and that can be useful, but at other times the idea becomes very different from what the writer conceived. I usually work with several approaches, but it is rare that the concept and composition comes first. First is the topic, then the collection of data and comparing of information after this step, and after analysing the information I start doing hand sketches of the composition and concept to find the most suitable one.”
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002 The crucial questions “It is very important to distinguish the superfluous from the point; the information from the explanation. Concepts such as ‘Who?’ ‘What?’ ‘Where?’ ‘When?’ ‘How come?’ and ‘Why?’ must be clear to you. Be yourself and try to innovate, but come from a classical base. The world of infographics is fascinating, and the opportunity to explain and convey concepts that otherwise would not be clear is always very rewarding. You have to learn what you are about to explain.”
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003 Breaking news I usually try to spend as much time as possible gathering the information needed for infographics, especially for complex ones. Further excess of information scope will be better, since you can discriminate and use it more accurately. The time I have to complete an infographic always depends on several factors, and they can be classified into three groups: ‘breaking news’ that requires completion in a single day; other pages that have a week or so; and then those that extend beyond two weeks.



004 Work in progress “After the first draft by hand, I do another more comprehensive development sketch, usually already in digital format, with Photoshop or Painter. The basic format for the infographic is usually an Adobe Illustrator document, and there I will be putting together the scanned art, digital or vector drawings. For many illustrations I combine freehand drawing on paper with Photoshop, and use it to draw and sketch using a Wacom tablet too.”
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revising. I research and sketch until I find a small moment of understanding, a little ‘aha!’ moment that I think I can explain to someone else. Design is a way of translating that understanding to print or screen. I try not to fall in love with a design or let design inertia keep me from throwing out an idea that’s not working. Revisions are incredibly important, and I try to clarify, simplify and revise more than I design.” Jonathan Corum (http://13pt.com)



© The New York Times/ Jonathan Corum



REFRESH AND REVISE “A compelling infographic must give the reader a non-trivial insight into the underlying data or information. It’s easy to make graphics that look impressive but explain nothing. It’s much harder to explain something visually. Most of my graphics appear in the science section of The New York Times, so I often start with a reporter’s rough draft of an upcoming article. I usually spend half my time researching the topic and half my time designing and



DEMOLISHING DETAIL



FOR THE 20TH ANNIVERSARY OF THE DEMOLITION OF KOWLOON WALLED CITY, THE SOUTH CHINA MORNING POST COMMISSIONED THIS INFOGRAPHIC FROM ADOLFO ARRANZ © Adolfo Arranz/South China Morning Post



Clarity of meaning To create a compelling infographic, Arranz believes it has to be clear about the information it is trying to impart: “Everything else is accessory in a way.” Case of composition “In this case,” says Arranz, “the composition works with a large image that covers everything and tells everything. The added elements work as a ‘side dish’.” Containing the chaos The chaos of the Walled City was “spectacular and unique” says Arranz, so “the challenge for me was to represent the city in great detail and at the same time be attractive.” Rooms to paint This infographic required a lot of artistic input. Arranz’s main tool is Photoshop’s brush, with different presets. He explains: “I like the spontaneity of the brush combined with the versatility of a Wacom tablet. Also artwork also worked on in Corel Painter.” Information first In this infographic, Arranz has the luxury of concentrating on artistic detail, but in others, there may be more information to fit in. That always comes first, he says, with your challenge being to “improve it aesthetically.” Decent timeframe Arranz had about a month between initial sketches and delivery of final art.



© New York Times/Jonathan Corum Paper



ACTIONS OF YOUR OWN As science graphics editor at The New York Times, Jonathan Corum has a particular range of topics that he comes back to again and again. Space is one of them, so he uses Photoshop to speed his workflow. He explains: “As a journalist I’m not allowed to retouch images, so when handling a news photograph I only make minor levels adjustments to help the image print well on newsprint. I have more flexibility working with



images as data, and have accumulated many Photoshop Actions for processing raw NASA images. And I’ve pushed the Photomerge tool as far as it will go, making thousands of panoramas from images of Mars taken by the Curiosity rover. It took me a long time to find the Auto-Align Layers tool, but that has been a huge help in making animations from archival NASA images,or from time-lapse images that are slightly misaligned.”



LET INFORMATION LEAD DESIGN “My organising stage involves writing each piece of information on a post-it note, which I stick all over my desk. Immediately I’ll start to see some patterns and links, but I’ll rearrange them for an hour or so, until I’m happy with the overall story flow and shape. This will then give me some ideas on layout, and if there’s a useful way of showing it. For example, if there are lots of separate groups of data, I’d tend to use a more modular design, while data with lots of connections might lend itself to a ‘tube map’ or flow chart style. I’ll then move these groups around, noticing any patterns or similarities; for example, there may be three groups of information featured, two large categories and one smaller one, which will dictate how the information is laid out on the page. Sometimes information can be ‘sliced’ in a different way, so you rip apart the groups you’ve made and find new connections and ways to structure the information. This is the fun part, and really lets you get inside the information.” Caroline Beavon



© Caroline Beavon/ Best By West Midlands 2013 White Paper



Objects into Photoshop (simply copy and paste) and arrange them into groups of layers (Background/ Illustrations/Text). Now comes the fun part: as I use a lot of textures for my kind of design style, I open my texture collection folder and start placing and masking. In Photoshop, I always try to follow my gut instinct. Experiment and improvise, and learn by trial and error. Finally, if necessary, I open Adobe InDesign to place text segments separately. InDesign has better possibilities for text formatting. It really depends on the project, but I’d say that research, collection, concept, data processing, pre-meetings/Skype sessions (not to forget about thinking and scribbling) make up the bigger part of the process; about two-thirds, sometimes more.”



© 2014 Michael Paukner, substudio.com



THE INFOGRAPHIC WORKFLOW For Michael Paukner, “step one is working out the concept (and presenting it to the client). Don’t forget to talk about pricing before you have sleepless nights because of head-scribbling. When I’m ready to press Cmd/Ctrl+N, I try to get in the right mood for designing by cleaning my desk and getting a hot cup of coffee. Step three is Adobe Illustrator. Working with vector graphics and global colour swatches makes things easier. As I try to work pixel-perfect right from the beginning, a perfect grid is essential. Back in school, descriptive geometry was my favourite subject and my work is still influenced by precision and the use of construction lines. I also have my golden ratio gauge always within reach. I then start to import the layers from Illustrator as Smart
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TAKE IT 3D “Where it gets really fun is when projects demand 3D visualisations. I use SketchUp, a wonderful, free app for 3D modelling. It’s nowhere near as powerful as the pro 3D suites out there, but its ease of use is very inviting and can be expanded with an enormous library of plug-ins. SketchUp itself does not create a realistic rendering, so I then throw the models into Keyshot, which can render an unbelievably realistic object with © Davvi Chrzastek very little effort. Prior to rendering, I also use Filter Forge to create high-res textures that add to the realism. Then there are countless little data-specific utilities that I may use only once for a particular project. When I had to create a 3D model of terrain in Afghanistan, I was given a DEM file that I’ve never come across before. I used SimpleDEMViewer to view it and get it into a more workable format.” Davvi Chrzastek



© 2014 Michael Paukner, substudio.com



TECHNIQUES INFOGRAPHIC ANSWERS



ASK, AND UNDERSTAND



DEVELOPING A BRIEF In this instance, the brief Caroline Beavon was set was “to present a collection of information about the work of a network of museum development officers in the West Midlands.” “The information was varied,” she continues, “and given to me as a text document. As I looked through the information I realised there were some definite categories, which matched the aims and objectives of the network itself. The structure of the infographic was led by the grouping of this information into those categories. The theme of the infographic was museums, so I specifically wanted a theme using ‘ephemera’ and old paper styles. It also gives the infographic some depth and interest on a purely visual level. Some of the information ‘chunks’ fell into more than one category, so I settled on the idea of the ‘tube’ lines, which created a series of pathways through the infographic.” Beavon explains that once she’s sorted through the data and come up with a concept, her usual approach is to “mock up either a sketch or a wireframe for the client to approve. They may have questions and queries about the layout – they understand their industry better than me, so their insight is invaluable. I’ll then work on a first draft, which will have some ideas of colours, themes and imagery, although this can evolve quite dramatically through the process. I always let the clients have a say over the creative direction – it’s their information and their brand – and I find it saves dramatic changes later if they’ve seen work in progress. Often clients will rethink the information they’re working with; seeing it on a page can highlight any gaps, confusing messages or simply whether the information is relevant to the message. As we work through the draft stages, we’ll develop both the information and the stylistic approach until we’re both happy.”
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Ways in “I enjoy infographics like this because there is so much information that needs to be presented. I like looking for connections and ways to show the data that allows the reader to choose multiple routes down the page.”



Bullets and balance “As the content was quite text-heavy, we broke it up with bullet points and columns to give the reader some variety.”



Ambitious navigation “This is a complex infographic, but I hope the readers would spend some time navigating the page, and discover more information as they browse.”



Building boxes “I started by putting all the information on post-it notes, and forming them into a grid of 5 x 4. I then used a mind-mapping tool called Gliffy to map the boxes out with the connections, to make sure that the lines didn’t cross too much, and boxes with multiple ‘lines’ were in the best place on the page.”



© Caroline Beavon/ The Marches Network



“Sometimes clients know what they want and sometimes they don’t. What I’ve learned is that a good briefing and a detailed preliminary talk with the client is really crucial. A fixed visual concept (and paper format!) saves time, nerves and money. So, if my client just has a vague topic in mind and asks for ideas of how we could turn their set of facts and/or data into an appealing infographic, then it’s my job as an information designer to provide advice and possible visual concepts. So, stay curious. Clients will offer you topics for infographics that you have never heard of before. You have got to stay open for new challenges. I have had data sets in front of me that were as clear as mud to me. But in the end I managed it. If you don’t understand the information the client wants to be communicated through your graphic, just ask. Sometimes these facts can be really complicated and tricky, otherwise they wouldn’t need further visual communication. If you don’t get the concept after asking, ask again. If you don‘t understand the information provided, you will not be able to create an appealing infographic as a designer.” Michael Paukner



PUT THE FACTS FIRST “I try to make elegant graphics, but I don’t make beauty a priority. I’d much rather have an ugly graphic that explains something well than a beautiful design that shows no insight or conveys no understanding. Information design is communication, not decoration. I try to show the right amount of information in a form that makes sense. The concept for a graphic should come from the data itself. You’re not doing information design if you decide on a form and then make your data fit. You’re just forcing graphic design onto a set of data. “Don’t worry about design or style. Worry about information. Find something you want to communicate, and then do whatever it takes to communicate that understanding. Learn how to design for others and avoid designing for yourself. You already know the story!”



ADD MOTION TO GRAPHICS



IN HIS WORK FOR THE NEW YORK TIMES, GRAHAM ROBERTS CREATES MOTION GRAPHICS AS WELL AS PRINT INFOGRAPHICS, AND SPORT IS A RECURRENT THEME
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STORYBOARDING GRAPHICS



“This is one iteration of storyboarding we put together to help determine the flow and structure of the All The Medallists, 100-metre dash graphic. We wanted to create a story that would focus on the overall trends in the data, but also bring a humanistic element in, and focus on some of the more interesting characters and results.”
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EXPLORING DATA



This is Roberts’ exploration of some Olympic results data. He estimates that about half of his time is spent on data collection and preparation, “though it of course varies with each project. Some graphics might be a simple chart or map, but take heavy lifting on the reporting/data collection side. Others might be elaborate on the production side, and start with more modest reporting/data collection.”



STARTING TO ANIMATE



“This is the beginning stages of assembling the scene that we would use to create the art/animation, based on the data, with figures in Maya. Creating a ‘virtual field across time’ in 3D. One of the challenges here was to find a style for the figures where they would be interpreted as being representative of data points, and avoid creating an expectation that they would actually look like each of those particular athletes. We used photography instead when we wanted to discuss particular athletes in the final piece.”



© The New York Times/Jonathan Corum



© Graham Roberts/The New York Times
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TECHNIQUES INFOGRAPHIC ANSWERS



© Davvi Chrzastek/Popular Science



manage both the thrill of finally being published, along with the terror of the task at hand. There was no draft provided with the project brief; just a couple of loose suggestions, along with a 100-page scientific document on the subject. Trying to read through it all only added to the stress and brought no ideas to mind anyway. Finally, I focused on one section that I knew was most important, and thought of the simplest way to chart it, without unnecessary complexities. Once that was done, it was easy to build on top of it and focus on making it visually entertaining.” Davvi Chrzastek



BOIL IT DOWN



034



turn your head 90 degrees). So, if you have to create an infographic for a blog that’s only 500 pixels wide, try to make it longer. Rearrange. Throw away. Try again. Until you’re happy.” Michael Paukner



© 2014 Michael Paukner, substudio.com



“You’ve got to know what you want to tell with your infographic. The particular information is what it’s all about. This gives me a kind of ‘grid’ for the final visual concept. Topic, target audience, publication medium and paper format also play a major role. You can‘t depict a yearly calender on a postage stamp. “Remember: ‘A picture is worth a thousand words.’ This quote is often cited when it comes to infographics. Humans process visual sets of facts or data quicker and more naturally than abstract textual information. A compelling infographic should present information in a visually optimised way, so it shortens the path to understanding. An appealing design and a creative wink or special idea that makes the infographic unique is what I prefer, not only as a designer but also as a consumer of information. How, and how much information you put in is secret of creating appealing infographics and what distinguishes an infographic from a great infographic. Don’t hesitate to ask your client to shorten the text passages that have to come along with the graphic if you think it’s necessary. If possible. If not, try something else. There’s always a way. Of course your infographic should be legible (also without having to



© Graham Roberts/The New York Times



BREAK IT UP “At first, I go back and forth with the client to get a good grasp on how we both want the data visualised. Once a rough draft is in place, I break it apart into sections so it’s easier to figure out what needs to be done, versus trying to jump into the entire project all at once. For example, an infographic I created for Popular Science on Afghanistan’s resources had four sections, one of which was infrastructure, and I knew it required building or finding 3D models. Breaking up a big illustration into small, manageable components makes it significantly easier to get the ball rolling. The very first time I was tasked with creating an infographic for a large, national magazine, I had to



ESTABLISH THE HIERARCHY “Graphics often go through numerous iterations before we settle on the best approach. Ultimately, we want the information to shine through. We don’t want the graphic to be lead by the design, it should be the opposite. Ultimately, the form we choose should be the one that creates the least distance between the data/ reporting and understanding by the reader. That doesn’t mean that we can’t use design to create engagement, but in my opinion good design and good function are inextricable partners. “Find the story that needs a visual explanation, report that story, based on that reporting find the element of the story best revealed by visual explanation, choose a form that fits this need, collect any data/assets needed, develop a hierarchy to direct attention for the reader, SKETCH, design, produce. “My feeling is that if you’re getting the sense that you are ‘cramming’ information in, it might be best to re-think the form you are telling the story in. It’s our job in part as journalists to find the most interesting elements of a story, and communicate that through a clear hierarchy, even if we are presenting the full picture of an event or data set. Communicating clearly will make for an attractive graphic.” Graham Roberts



© Caroline Beavon



TAKE A LOOK AROUND YOU “Sometimes a particular data set will lend itself well to a map, a series of relevant icons, or any of the traditional charts, but it all doesn’t always snap into place like that. I look through my ‘Design Reference’ library of works I’ve collected over the years of both my projects (including visuals that never made it into the final piece), and illustrations from other designers with creative approaches to visual challenges. Even if I don’t find something close to what I’m working on, as is often the case considering the varied nature of infographics, just looking at other diagrams, charts and infographics helps me to get my creativity going. Look around you and notice how much we’re surrounded by information being presented to us. A bus schedule, a subway map, a parking voucher, labels on an oven, icons on your phone; countless opportunities to see what creative challenge was met, and what doesn’t work. Take a few seconds to imagine how you would have handled it. Take a photo of it and put it in a ‘Design Reference’ folder, along with any infographics that you admire. Keep going back to it for inspiration.” Davvi Chrzastek



BALANCE INFO AND APPEAL “If the infographic doesn’t look appealing, it won’t draw the reader in, but if the content is weak or limited, then they’ll leave feeling a bit conned! The key for me is being open to change throughout the process, so as the layout develops the content may need to change (ie for layout reasons). “It’s hard sometimes to imagine how a spreadsheet of numbers will look on a page, and it’s amazing how that space fills up! Also, if the content is quite technical or dry, I’ll make sure the



design is appealing enough to carry the reader through. Clients are always pushing to get more information in there and it’s easy to create something that’s quite messy and visually unappealing. If we are hitting this problem, I ask the client to review the information and highlight anything that can be dropped if needs be. This really gets them to focus on the important elements, and prepares them for having to let something go!” Caroline Beavon



It’s our job in part as journalists to find the most interesting elements of a story, and communicate that through a clear hierarchy, even if we are presenting the full picture of an event or data set. Communicating clearly will make for an attractive graphic



Graham Roberts, www.grahaphics.com



© Davvi Chrzastek



035



ON



TAKE A SNEAK PEEK BEHIND THE SCENES OF SOME OF THE WORLD’S BIGGEST GAMES AND LEARN HOW PHOTOSHOP IS USED TO CREATE THEIR IMPRESSIVE ARTWORK



Execution: Done to set the mood of a sequence of Assassin’s Creed Unity. The image was entirely painted in Photoshop and took Gilles Beloeil about a week to complete



MEET THE EXPERTS KAIT KÜBAR CONCEPT DESIGNER



WWW.KAITKYBAR.COM Kübar is a freelance concept artist and visual designer from Estonia. He has worked for Guerrilla Games on Killzone: Shadow Fall and a new unannounced project for Sony’s PS4.
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ANDREW VASILIEV FOUNDER/2D ARTIST



WWW.KRATAVRAT.COM Andrew Vasiliev has been working in the games industry for over six years. As a self-taught artist, he has recent launched his own studio – Kratavrat – which specialises in making games for mobiles.



JAMES PAICK CREATIVE DIRECTOR



WWW.SCRIBBLEPADSTUDIOS.COM As a concept artist and founder of Scribble Pad Studios, James Paick works mainly in the videogame and film industry, as well as theme park design, tutorials and illustration.



FINNIAN MACMANUS CONCEPT ARTIST



WWW.FMACMANUS.COM Macmanus is currently a student at the Art Center College of Design in California. He has been working in the entertainment industry for several years, and focuses on 2D and 3D environment concept design.



JULIO ZARTOS ILLUSTRATOR



WWW.ZARTOS.STRIKINGLY.COM Zartos has worked in some form of art and illustration all of his working life, including creative retouching and for a short time, as a professional guitar player.



MEG OWENSON CONCEPT ARTIST



WWW.LASTSIREN.COM Meg Owenson works as a concept artist/illustrator in the entertainment industry specialising in environments, set design, key and mood concept art. Past clients include the US Navy, Fantasy Flight Games and Helm Systems.



GAME ON TECHNIQUES



artist Jedd Chevrier, who says: “Concept artists are designers that use drawing, painting and 3D as their vehicle of communication. Finding ways to consistently generate inspired, creative and original ideas is important and highly sought after.” In addition to this, creative director James Paick also believes that “the hardest part of working in this industry is that you must be prepared to perform at your highest level on a daily basis. As an artist, you’re always learning new things every day, both about the craft and about the world around you. The more knowledge you have of how the world works, the better you communicate that within a painting.” Although the cut-throat world of concept art is not for the faint hearted, we are reassured that it is one of the more rewarding genres to work in due to the freedom given to the artist.



Getting the commission details before the game is built means that imagination can take over rather than being constrained to every detail. Illustrator Mateusz Szulik agrees: “When working in the advertising industry, I got a lot of great projects, but making games is something different. You can have crazy ideas and just realise them; you can develop beautiful new worlds or creatures.” We spoke to a number of top industry professionals who, over the next nine pages, share their top tips on composition, colour theory, character building, masks, blend modes and layers. We even cover the exciting changes to game design, including the rise of games for mobiles, tablets and the internet. Read on to discover tried and tested tips.



t use drawing, f communication. Finding ways to consistently generate inspired, creative and original ideas is important and highly sought after Jedd Chevrier, www.jeddchevrier.com



JEDD CHEVRIER LEAD CONCEPT ARTIST



NICCOLO BALCE ILLUSTRATOR



777*%$$#(%62)%2#/After majoring in illustration at art school, Chevrier has worked on projects for Transformers and Doner. He has also freelanced for Hasbro and mobile games and continues to work on his portfolio with Microsoft Studios.



2/"/4.)##45-",2#/Niccolo Balce is an illustrator who has a soft spot for 80s and 90s nostalgia. He started freelancing in 2003 and now works for Disney Interactive.



GILLES BELOEIL SENIOR CONCEPT ARTIST/ILLUSTRATOR



JULIEN RENOULT AKA LEEROY VANILLA CONCEPT DESIGNER



GIA NGUYEN CONCEPT ARTIST/MATTE PAINTER



MATEUSZ SZULIK FREELANCE ILLUSTRATOR AND 3D ARTIST



777'),,%3"%,/%),#/Starting his career as a lighter in the VFX industry, Beloeil became a concept artist at Ubisoft Montreal in 2007 and has been working for the Assassin’s Creed games since 2008.



,%%2/96!.),,!",/'30/4#/5+ Renoult is a French artist living and working in the US. Currently a concept designer at Insomniac Games, he learnt animation at Gobelins School and anatomy at École des Beaux-Arts in Paris.



(440')!˶.'59%.#/Gia Nguyen is a professional concept artist/matte painter based in Saigon, Vietnam. With over four years of experience working in the entertainment industry, Nguyen specialises mainly in environment design.



777-!43:5,)+#/Mateusz Szulik is a self-taught freelance illustrator and 3D artist based in Poland. He loves creating new sci-fi worlds, but also working in other fields, like illustrations for children.



© 2014 Ubisoft Entertainment. All Rights Reserved. Assassin’s Creed, Ubisoft, and the Ubisoft logo are trademarks of Ubisoft Entertainment in the US and/or other countries.



T



he computer and videogames market is one of the most rapid-growing and lucrative in the entertainment industry. According to the Entertainment Software Association, smartphone and wireless device use for gaming in America increased by 22 per cent and 37 per cent respectively in 2013, with the rise of casual and social games being partly responsible. So, as nearly every device that has a screen now plays games, corporations are having to produce a whole host of new content for a more diverse audience. The artwork produced for each game must be just as varied, and when it comes to new concepts, artists are asked to create individual landscapes, environments and characters to help shape the future, finished game. The importance of those creative ideas is backed up by lead concept
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TECHNIQUES GAME ON CONCEPT ART



© Guerrilla Games



Eviction: This was a mood painting for the very beginning of Killzone. “It was interesting to see that it looks better in game,” says Kübar



BUILDING AN ASSASSIN’S CREED ENVIRONMENT SENIOR CONCEPT ARTIST GILLES BELOEIL REVEALS WHAT IT TAKES TO BUILD A TYPICAL ASSASSIN’S CREED ENVIRONMENT IN PHOTOSHOP “The first thing I do is to look for as many visual references as possible. This is very crucial; I can spend half a day on colour, lighting, objects, composition and character poses. After picking colours in photos or illustrations, I begin to paint. If you want to build a concept environment, start with big shapes first followed by the details. I use the Lasso tool to make my selections and paint inside them. I also change layers each time I think about it and I collapse them when I think I have something interesting I want to keep.



La Clairiere



“I then use the Gradient tool often, to avoid hard edges as much as possible, and apply Curves to change the value or colour of a specific area. Try to vary your brushes, but I recommend using only four or five different ones. I always pick a colour and paint one or two brushstrokes, then pick another one and paint again. This ensures variety. At the end, I do some colour corrections on the overall image and darken some areas like the corners of the frame.”



© 2012 Ubisoft Entertainment. All Rights Reserved. Assassin’s Creed, Ubisoft, and the Ubisoft logo are trademarks of Ubisoft Entertainment in the US and/or other countries.



Concept art has always had to cover many subjects. Being the primary medium for game designers to work with, it is imperative that the images are produced to a high enough standard. Finding a balance between creating fantasy and basing your images on reality is no mean feat; then there’s the perspective issue, colour correction and of course the deadlines. As an extremely fast-paced career choice, you have to know what you are letting yourself in for and be prepared to follow set rules when creating the work. Concept designer Kait Kübar has experienced this for himself when working on Killzone: Shadowfall. “Killzone has very specific style. Before I got [the] freedom to play around, I had to learn how the design works. So, the idea was simple: be creative but don’t wander too far.” Senior concept artist Gilles Beloeil also recognises this. For his Assassin’s Creed: Lineage work, Beloeil experienced “a tough ride. I had to make complex matte paintings with camera movements. 90 per cent of my work consisted of fixing technical problems and 10 per cent of fun painting only… but the end result is cool!” To avoid getting on the wrong side of the team and producing sub-standard work, there are various boxes that should be metaphorically ticked off before finishing an image. Mateusz Szulik believes that artists should consider how to make the concept look great, realistic and usable, all at the same time.



James Paick, www.scribblepadstudios.com
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ARTIST JAMES PAICK EXPLAINS THE WORKFLOW BEHIND THIS HELICOPTER SCENE FROM MEDAL OF HONOR BLOCK OUT



I started this particular piece by blocking in the walls, floor and ceiling. Once I had the foundation of the room laid out, I then designed within that space and really set-dressed the environment to fit the needs of the project brief.
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LAY IN
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© Danger Close Games/EA Games



I loosely indicated where I wanted all my items in the scene, and then designed out what I wanted them to be. After indicating a particular item, I could then utilise the rules of perspective to repeat that object back in space, while keeping the design and scale believable.



FINALISE



Once I had all my objects in place, I could then finalise the design of the picture. Then came solidifying the painting and lighting it. I can control the viewer’s eye with lighting, showing them specifically what I want them to see.



Photoshop as a central part of their workflow. However, with the rise of 3D films and games, 3D software use is becoming more and more widespread. Do all concept artists have to use 3D software as well as Photoshop? “There are times when a client provides a 3D base for me to work on, but personally I solely use Photoshop for my artwork. I find it a good experience to master one image-making tool before venturing off onto other platforms,” Paick tells us. Alternatively, there are artists who have embraced the world of 3D and use it in their everyday workflows. Szulik is one of them: “In my opinion, Photoshop works great with 3D. I use it all the time in many aspects of 3D – sketching ideas and concepts, creating textures, overpainting 3D scenes and post-production.”



Lost Planet 3 – Mech Design: After exploring quite a bit, Scribble Pad Studios finally narrowed down a design to flesh out. Even before this stage, there were revisions to the mech design to make sure it would suit the project’s needs © Spark Unlimited



It’s easy to get lost in the program if you let the tool control you instead of controlling the tool



MEDAL OF HONOR BREAKDOWN



Last Stand: Using detailed level design, Kait had to create a lighting pass to make the image more realistic



© Guerrilla Games



“From a technical point of view, I try to ask myself some basic questions: ‘Could it really work like that?’ ‘Could that plane really fly in the air?’ ‘Will that mech be able to walk?’ and ‘What will that device do?’. Even once you have thought up an image or have been given commission details, building the concept can be quite a complex task. As most concept art is built in Photoshop, there are a lot of things that can go wrong, so sorting guides and layers is very important. “I have a group for my guides (perspective lines, drawing, photo references), a group with the few layers I am painting on and a last group with some previous versions of my image,” says Gilles, “just to be sure I am still in the right direction.” Paick also highlights the complexity of working in Photoshop and how easy it can be to go astray: “Photoshop is great in the sense that it offers countless ways to achieve a certain result. Although, that aspect of it can end up being a gift and a curse, since there are infinite ways to get to a result, it’s easy to get lost in the program if you let the tool control you instead of controlling the tool.” It goes without saying that most digital artists still use
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TECHNIQUES GAME ON ENVIRONMENTS AND LANDSCAPES
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&)..)!.ď-!#-!.53ď')6%3ď!ď34%0˶"9˶34%0ď'5)$%ď4/ď#2%!4).'ď ()3ď&!.4!34)#!,ď%.6)2/.-%.4 COLOUR BLOCK IN



The colour block-in phase is similar to building the anatomy of any piece. Everything here will for the most part decide the composition and feeling of the work – it will show the mood, major elements, and lighting. I focused on loose gesture for the forms, trying to get a mysterious but vibrant look to the scene.
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COMPOSITION AND CONCEPT



I developed the scene more, adding elements that would hint at the type of world this was, and adding some compositional changes to make the image more powerful. I worked on the lighting and texturing a bit, applying details in some areas I thought were complete.



DETAILING AND FINISH



© Finnian MacManus



The final step was further refinement of the concept, populating the world with the elements I had created, and detailing the focal areas with textures. I made the lighting a bit more dramatic, and used some atmospheric perspective to get the depth in the scene that I desired.



Artists working in the entertainment industry have to know so much. There is no quick fix for this, even though we work digitally Meg Owenson, www.lastsiren.com © Finnian MacManus



Realism is key to a successful environment concept. Even a fantasy image needs to look relatively believable. “Because of the need for realism in my work, I have learnt a lot of matte painting techniques so that I can work with photo textures.” Concept artist Meg Owenson adds: “For this I find Channels to be a powerful tool. It allows me to cleanly cut out plants and other tricky elements like clouds to implement into my work.” Landscape composites get infinitely more complex, meaning that the original commission request can get lost if you aren’t careful. This is where the difference between a concept artist and an illustrator becomes relevant. “I am a concept artist rather than an illustrator, so I am more concerned with the mood and ideas within the piece rather than getting a painting that is perfectly rendered,” says Owenson. “Illustrators can take months on one painting, but when you are working in a studio your art director might want one or two paintings done before lunch.” There are a number of important aspects to look out for when building your image. Concept artist Finnian MacManus believes that proportion and shape are key. “In terms of composition, I always try to consider the read of the image: How fast does someone understand what’s going on? How can I improve that? I always think about how every element relates to each other, how they contrast, whether it be by shape, hard or soft edge, and how they add or take away from the composition.” Owenson believes it is all about the fundamentals. “Lighting, colour, values etc. Artists working in the entertainment industry have to know so much. There is no quick fix for this, even though we work digitally.” She adds “Lighting is something that I find most important when creating any kind of painting. If you can create an interesting lighting scheme, then half your work is done.” As for Photoshop tools and techniques, since the release of new features in both CS6 and more recently in CC, artists like Chevrier have found new



2D ENVIRONMENT CONCEPT ART



Acrospar Ruins: &ORďTHISďSCENE ď&INNIANďMADEďAďBLACKďANDďWHITEď READďBEFOREHAND ďWHICHďLEDďTOďAďSHARPERďIMAGE



solutions to previously unsolvable issues: “The new mixer brush features are excellent. They have really helped me bridge the gap between my digital and traditional workflows.” Artist and matte painter Gia Nguyen adds: “There are also a number of new overlays including Golden Ratio, Golden Spiral, Diagonal, Triangle, Grid and Rule of Thirds that are useful and the Auto-save feature should have been in Photoshop a long time ago!” Chevrier agrees: “I have had so many scenarios where this has saved me hours of work.” A tip for those that want to improve workflow speed is to create shortcuts. “Time is everything when you are working as a concept artist. You can’t be slow, so I make full use of the shortcut commands and have set up a lot of actions to allow me to quickly do things such as flip the canvas; that way I can see mistakes in my work [more easily].”
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© GlassEgg digital media



This Be Wild Country: “I implemented some photo textures, making use of the layer styles, channels and really pushing THEďDETAILS ƒďSAYSď/WENSON



qď-EGď/WENSON



Mechs Hangar: “4HISďWASďCOMMISSIONEDďBYďTHEďARTďDIRECTORďTOď use as the menu screen for the game,” says Nguyen



CREATE A COMPLEX LANDSCAPE



JEDD CHEVRIER TELLS US HOW HE CREATED THE ENVIRONMENT PIECE FOR PROJECT SPARK



Blending modes Here I used both the inner glow, and outer glow blending mode options to give this energy tendril an extra kick.



© Microsoft Studios



Custom brushes The grass and some of the texture on the rock I got from using the Scatter setting on a few of my brushes.



Clean layers Layers really allowed me to nail my composition. I try to keep clean layers so I can nudge and arrange things around when necessary to avoid tangents.



Mixer Brush For the clouds I like to use the Mixer Brush to push and pull pixels around – this can give a very traditional look and feel to the paint.



TECHNIQUES GAME ON



CREATIVE AND TECHNICAL ADVICE



SENIOR CONCEPT DESIGNER JULIEN RENOULT SHARES HIS TOP TIPS FOR CHARACTER DESIGN



■ Creatively Having a good reference is the most important part in finding new ideas. I have collected tons of images, from antique to contemporary, and I enjoy mixing them together. ■ Technically In technical terms, it is important to remember to make all changes on a new layer. Begin with a small sketch to fix the shape, create a second layer and draw the lines and details. On a third layer, diffuse colour and use the fourth layer to add shadows in Multiply. The fifth layer should be used as a specular in Overlay and the last layer to make your final changes.



Inside my mind, I create a story for them.” Nguyen agrees and is happy to extensively research a subject before starting a commission. Nguyen also believes that the first thing a concept artist must think about is the main function of the character – or in this case, machine – and then follow up by thinking about the design. “‘Form follows function’ is a principle associated with modernist architecture and industrial design and now concept art. Because everything we create appears in games or movies, it has to be believable to audiences, and usable for the characters in it.” For Chevrier, the narrative is the most important. “What should be the initial emotional reaction that you want to pull out of your audience for that particular character? After that is satisfied, what are the qualities, shapes and design motifs that make that character memorable? Make sure that you’re asking yourself the hard questions and also answering them.” Nevertheless, some procedures deserve more of your



attention than others. When senior concept designer Julien Renoult is drawing in Photoshop, he gives himself precise guidelines to follow. “I have a strict process with the layer properties, especially for the rendering and the colour stages. When I use 3D or photos, I play more with masks and adjustment layers.” For Zartos, it is more important to set up “the character details by drawing the construction of the body on black and white. Draw the additional elements on a separate layer and add them only when needed.” However you choose to create your character or machine, everyone agrees that brushes are very important. Even if your image is not created through traditional digital painting methods in Photoshop, they are still used to add light, shadow and realism to your scene. “I like the default brushes; they work pretty good for me. So, at this point, I don’t use any different brushes to anyone else,” says Zartos. “I would like to highlight the Mixer Brush tool if you want to get fantastic effects.”



What should be the initial emotional reaction that you want to pull out of your audience for that particular character?



Jedd Chevrier, www.jeddchevrier.com



© GlassEgg Digital Media



The path to becoming a successful character and concept artist is never smooth. However, every professional that we spoke to suggested that you should practise every day to improve your skills before applying. “Make sure that you have your fundamentals down. Drawing, painting, perspective, anatomy, colour theory, etc,” says Chevrier. “At some point in your career you will be asked to design something you’re completely unfamiliar with, or something completely ridiculous. Your ability to dissect, design and visually communicate those ideas is built upon those fundamentals. You need to be able to confidently rely on those skills.” When it comes to actually designing a character, the ability to make it look realistic is key. It really can make all the difference between an image that is easy on the eye, to one that just doesn’t make sense. We discussed a typical image workflow with illustrator Julio Zartos, who believes that you should start with research. “After receiving the client briefing, usually I research everything that is related with the game.



Sunset Overdrive Character Grouping: This picture was done to fix the art direction of the character for the game Sunset Overdrive. The idea behind this group is also to show the variety of characters that the gamer could play.



© Insomniac Games / Microsoft



CHARACTER AND MECHANICAL DESIGN



© Julien Renoult



In these images you can see the way that Renoult has followed his own processes in Photoshop in order to build his character: adding the shape and the outline, followed by shading and finalising the colour
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Quadruped Walker: One of many initial mech concepts Nguyen did for the mech racing project. These are just for style exploration and to give the production team a quick look over the project style. The concept is discussed further based on that



PAINT A CYBORG



CHECK OUT JULIO ZARTOS’ WORK FOR WWW.DOWNLOADC3.COM



01



SKETCH



In the beginning, I usually like to start sketching in black and white, with a hard brush such as an oil pastel brush in large. Here, the most important thing is to let the imagination flow. I just knew this character should be a strong cyborg, capable of carrying a heavy weapon.
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VOLUME CONSTRUCTION



Still working in black and white, I built the character’s shape by adding volume through light and shadow. I still used the hard brush, but I also worked with a softer brush. I could now see what the character would look like and the paths I had to follow to get where I wanted.
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COMPLETION



When the details were almost finished, I began to colourise it. To do this, I used a Color blending mode layer over the black and white character’s layer. Adding colours and more details is a long process; make sure you merge all the layers together and then insert textures as well. After that, the red lights on the character were made using a mix of hard and soft brushes, blended between Color Dodge and Screen layer effects.



TECHNIQUES GAME ON ONLINE AND MOBILE GAMING



Final pass After all groups look good with each other, I flatten each one of them. This allows further tweaking without confusion.



3D props I used Blender to make the arcade cabinet. Then I rendered it out as three separate PNGs.



Colour flats and shade layers I keep colour flats separate from the shading so colours can be shifted as much as I want before finalising.



© Niccolo Balce



With the games market no longer restricted to just consoles, artists have had to regularly adapt their illustrations to make them accessible across different devices. Senior 2D artist, Niccolo Balce, discusses the challenges that have resulted from this change: “When working on mobile games, my output mostly has to be saved out as different sizes. The assets have to be saved out just a few notches smaller than print size for mobile and it has to be way smaller for the social or online version. I also have to keep things within templates that were established by the engineers and the UI designers.” When setting up your predicted workflow, it is important to take this into account and allow for the extra time. “Making artwork within the constraints of the UI designs and the limitations of a game engine demands more time in finishing assets. But it’s just a matter of getting used to and keeping open communications with your co-workers.”



Sub-elements Here’s an example of the grouped layers: I always have a line art, a colour flats, and a shade layer.



Major elements My illustrations are usually split into three groups: a foreground, midground, and a background, each with their own layers.



Making artwork within the constraints of the UI designs and the limitations of a game engine demands more time in finishing assets Super Comboman: This one was for the Super Comboman art book, which was one of the rewards for the Kickstarter backers. It was also used for their flyers.



© Nicc Balce, Jillian Ogle (Aylo Games)



Niccolo Balce, robotnic.tumblr.com



FOUNDER OF KRATAVRAT STUDIO, ANDREW VASILIEV, GIVES HIS TOP TIPS FOR CREATING GAME ART FOR ONLINE OR MOBILE DEVICES.



2Bix: 2Bix was a huge departure from any of Balce’s other projects since it encroached onto UI design territory. He designed the gems, the game board’s look and the general feel of the game’s visuals.



■ Limiting the number of textures: To improve performance and reduce the size, games always try to reduce the overall size of the texture, and thus the graphic elements. Here you have to sacrifice either number of unique elements, their size, or their quality. ■ Colour rendition: If the game comes out not only on iOS but on Android and other platforms, it will look different on the different screens: darker, brighter, more contrast or more saturated. It is necessary to find the golden mean for original graphics to make it look good on any screen, at any size.



© Kratavrat



© MojoBox Games



© Nicc Balce, Interabang Entertainment



Animal characters from Go Go Armadillo: Each animal was carefully designed based on real animals but slightly shifted to give them comic status. Designs were created in collaboration with Mojobox Games.



■ Screen size: If the game’s for a phone, you definitely need to create such graphic content that will be read at a small size. All items must be clean, clear and recognisable.
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Opening comics first page: This is the first version of the opening image for the Beaver Kickin’ game. It will be animated, with the camera moving slowly through the whole picture showing all of the details.



NVIDIA® QUADRO® #1 IN THE HEARTS, MINDS, AND WORKSTATIONS OF DESIGNERS EVERYWHERE



NVIDIA Quadro graphics cards are the most trusted in the world, empowering 80% of design professionals to do their best, most important work across the widest range of applications. Quadro solutions can help you accelerate your workﬂows, enhance your results, and maximize your productivity, whatever conﬁguration, model size and complexity, or views you use. ®
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Insight
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CREATE GAME ART TECHNIQUES



DIGITAL PAINTING



CREATE GAME ART FLESH OUT A FULLY RENDERED CONCEPT CHARACTER USING CUSTOM BRUSHES AND ADJUSTMENT LAYERS



W



hether it’s for games or for movies, there are no rules when it comes to creating character concept art. You can use any tool within your grasp in order to augment your painting process and to flesh out your character as your imagination tells you. When doing work of this kind, Photoshop comes in handy. Here, you will be taking advantage of its power in order to create a fully rendered character concept that isn’t simply a snapshot. This tutorial will cover the complete painting process. You will use different tools and techniques



to paint a female character who could be the protagonist in an action game – a femme fatale inspired by the likes of Chun-Li. You will learn to develop the picture from a rough thumbnail sketch and discover how this task can be done with the use of custom brushes and blending modes. Some of the brushes you’ll use here mimic traditional media to a certain extent and will be very useful in adding textures to the piece. You’ll also make use of adjustment layers and filters that can influence the overall mood and atmospheric perspective of the picture.



START WITH STUDIES



OUR EXPERT JOHN BRIAN S. CASACOP



www.jbcasacop.deviantart.com



JB Casacop is a mobile games designer by day and a fantasy illustrator by night. He has made dozens of artworks for games like Star Wars LCG and Warhammer: Invasion.



SOURCE FILES Provided online are Jan Ditlev Christensen’s fine art brushes that behave like traditional brushes. Other brushes used in this tutorial can be downloaded from http:// danluvisiart.deviantart.com/art/ My-Brush-Pack-118954791 and www.ramonmiranda. com/2010/04/photoshop-artisticoils-brushkit.html.



CREATE SKETCHES THAT WILL GUIDE YOU THROUGH THE ENTIRE PROCESS
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TONAL THUMBNAILS



Regardless of how detailed you plan your artwork to be, always begin by creating tonal thumbnails. The purpose of this step is to make quick compositions that will help determine which pose and what kind of lighting will work best. It doesn’t have to be polished. You just have to make sure there is ample distinction between the figure and the background.
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COLOUR THUMBNAIL



Once you’re happy with your tonal thumbnail, start adding colours. There are several ways to do this. You can either set your tonal thumbnail as a Multiply layer then paint underneath, or just paint on a layer with the blending mode set to Color, or simply paint over it. You can also do a combination of all those methods.



WORK IN PROGRESS



BUILD UP FROM A ROUGH SKETCH
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TIGHT LINE SKETCH



The thumbnails will serve as guides when rendering the piece. After making them, the next task is to finalise the form of the figure by creating a tight sketch. Use any hard-edged brush to draw the figure as you would using pen on paper. Make use of the Line tool to create straight lines. Progress 1: Create thumbnail



sketches



Progress 2: Add colours



Progress 3: Finishing touches
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TECHNIQUES CREATE GAME ART
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SEPARATION OF ELEMENTS



Now you need to separate the picture’s elements using silhouettes. Use the Pen tool to select each element, such as the figure, then fill them with any colour. Make sure each selection is made on a different layer. Duplicate the line art layer on top of each silhouette. Ctrl/right-click on each line art layer and select Create Clipping Mask. Alternatively, you can just put the mouse cursor between the line layer and the silhouette then Opt/Alt-click.
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INITIAL BACKGROUND ENHANCEMENTS



Now that you’ve rendered the background, you’ll need to create two new layers on top of it. Change the blending mode of the first one to Color Burn and the other to Color Dodge. Use an airbrush to enhance contrast and colours. This method, while less automated compared to using a filter or an adjustment layer, provides greater control because it allows you to choose specific areas to darken, lighten, or intensify. Having these enhancements on separate layers makes the file more editable.
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BROAD STROKES



With each element separated into individual layers, your next step would be to introduce colours using broad brush strokes. Before painting on a selected layer, click Lock Transparent Pixels. This will ensure that the silhouette of that layer is preserved. There is no need to be concerned about polishing at this point. You will revisit each element later after the basic colours have been laid out. This is where the colour thumbnail becomes useful as it can be used as a guide in this step.
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RENDERING THE BACKGROUND



One of the better approaches to painting, be it digital or traditional, is to render the most distant elements first. In this case, it’s best to begin with the sky and the shipment containers behind the character. Use Jan Ditlev Christensen’s fine art brushes (provided online) for the hard surfaces. For the clouds, use Dan Luvisi’s custom brush pack (link provided). To control the ‘amount of paint’ in each stroke, access brush presets and set Opacity and Flow jitter to Pen Pressure.



QUICK TIP Aside from brushes, having a library of royalty-free textures is also beneficial. You can use them in conjunction with the brushes you download or perhaps even make your own custom tools out of them. This will make painting in Photoshop even more efficient and enjoyable for you.
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ADDING TEXTURE



One of our objectives is to visually convey an idea. Keep in mind that no matter which style or genre you’ve chosen for your painting, it has to be believable. Even if your painting is stylised as opposed to photorealistic, there are still merits in adding details such as textures that make the artwork all the more convincing. It’s a good idea to build up a library of free textured brushes that can be downloaded online, such as Ramon Miranda’s Artistic Oils Brushkit (link provided).



BRING YOUR PAINTING TO LIFE



USE DETAIL TO EMPHASISE KEY ELEMENTS IN YOUR WORK
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RENDERING SKIN



After fine-tuning the background, it’s finally time to render the character. Start with the skin. Concentrate on the facial region first. Her face is the part you have to pay extra attention to because it’s the one that tells the most about her mood and character. When rendering skin, use hard-edged round brushes and airbrushes without any texture settings in order to achieve a soft and smooth kind of finish. This will also improve the distinction between her and the background that consists of hard and rough surfaces.
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CHECK FROM AFAR



There are still certain methods in traditional painting that should be kept in mind. You shouldn’t fixate too much on the details. As in traditional painting, you must look at your work from a distance every once in a while to check the general composition. Clicking Window>Arrange>New Window for [filename] will allow you to have any number of extra views of your painting. By having these extra windows, you can evaluate how much the painting is being changed by the details you’re currently working on.



Sometimes, there are errors in your painting that only become evident once you see a mirror image of it
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DO THE FLIP TRICK



Sometimes, there are errors in your painting that only become evident once you see a mirror image of it. Flipping your image exposes any awkward placement of elements or errors in proportion. To perform this checking method, click the top-most visible layer in the Layers panel then stamp visible layers by pressing Cmd/Ctrl+Opt/ Alt+Shift+E. This will create a flat layer that you can easily flip using the Transform command. You can now look at your art from a fresh perspective.
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PLACE DECALS



By definition, decals are labels that can be transferred to a surface from specially prepared paper. They are commonly used in scale modelling. In the digital arts industry though, decal also serves as an informal term used by artists to denote any graphic element that is prepared separately before being integrated into another artwork. By using the Rectangular Marquee and the Type tool, you can create simple logos that can be used as decorative details. To integrate them into the painting, use a combination of Transform tools and painting-over.
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CREATE PATTERNS ON THE CLOTHES



In traditional painting, you can add patterns on drapery by either making use of stencils or by doing so manually. Both methods can be quite laborious. Thankfully, Photoshop offers a certain solution. Make use of the Pen tool or the Lasso tool to isolate a portion of the character’s clothes. Colourise your selection using a Gradient Map which can be accessed by clicking Image>Adjustments. In a nutshell, Gradient Maps allow you to apply different colours to different values in your images, making them ideal for patterns on folded drapery.
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TECHNIQUES CREATE GAME ART



COMPLETE YOUR PAINTING &).!,ď%.(!.#%-%.43ď!.$ď0/34˶02/#%33).'
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ENHANCEMENTS ON THE CHARACTER



Similar to the process done after painting the background earlier, make use of a Color Dodge and a Color Burn layer to enhance the values and hues of the character. Since the background consists primarily of greens and blues, you should accentuate the character further by using warmer colours. With soft brushes, apply some red-orange hues along the edges of the character on the Color Dodge layer. Then, for the shadow enhancements, apply some light greys and various shades of purple on the Color Burn layer.
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GENERAL COLOUR ADJUSTMENTS



Once you’ve painted all elements, care must be given to ensure that all elements look like they belong in one scene. This is where adjustment layers come in handy. In this case, use Color Balance to simultaneously adjust the hues of the character and the background. Naturally, certain hues will be pushed too much as a result. To remedy this, apply some black paint to the layer mask that comes with the adjustment layer. This will allow you to ‘erase’ parts you don’t want the adjustment layer to influence or affect.
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ATMOSPHERIC EFFECTS



The last step in this tutorial that would involve the use of brushes would be the addition of atmospheric effects such as bloom. Bloom is an effect in which the light extends beyond the borders of bright areas in the picture. To add this particular effect, you will simply need to create a new layer and set its blending mode to Screen. Then you will need to make use of an airbrush to lightly paint those light fringes. Take care not to overdo it though, as you don’t want any part of the background to be too washed out.



CHROMATIC ABERRATION



Chromatic aberration is actually a form of distortion caused by camera lenses that photographers attempt to correct. This can be avoided altogether in digital painting since you’re not using a camera. It can also be deliberately added to make your painting look a little less artificial. To do this, stamp visible layers then Ctrl/right-click to access Blending Options. In the menu that pops up, just uncheck any of the three channels. After closing the menu, use the Move tool (V) to slightly reposition the layer to simulate chromatic aberration. QUICK TIP Learn how to use various adjustment layers to your advantage. When you are working in the game industry, you never know what changes your clients or art directors might request. Oftentimes, you’ll be expected to make those revisions quickly, so you need to have as much control as possible.
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FINISH WITH A BIT OF NOISE



The finishing touch would be to make use of a noise filter on your painting. You may consider this step optional if you want to go for a smooth kind of look. Some artists do this extra step in order to keep their paintings from appearing too computer-perfect. It creates a subtle change that probably won’t matter if your image is intended to be scaled down during print or for use on a website. In this example, an Amount of 2.5% was used for the Add Noise filter.



THERE ARE NO RULES, ONLY TOOLS This tutorial shows but a few approaches to creating a concept character. There are an infinite number of ways to come up with the effects in the painting we have here. You can spend a lot of time in the line art phase by checking proportions there and finalising the anatomy instead of just making corrections in post-production. You can make use of royalty-free photos instead of manually painting textures, or use the Smudge tool to blend your colours instead of relying on Pen Pressure settings. Don’t be afraid to experiment. It’s still the best way to get oriented.
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CREATE CLASSIC TYPE TECHNIQUES



TYPOGRAPHY



CREATE CLASSIC TYPE LEARN HOW TO CREATE A RETRO CHALK TYPE EFFECT WITHOUT THE SKINCRAWLING SCRAPING



A



s we free-fall mercilessly to the halfway point, the 2010s are fast becoming known as the decade when we all pretended to live in every other decade except for the one that we’re actually in. From the 90s revival to mid-century-tinged typefaces that proliferate the internet, nostalgia is clearly the new black. I’ve never believed in ‘timeless design’; beautifully designed things are always called timeless at first and then people eventually tire of it and inevitably it falls out of fashion. 20 years later, in a reaction to the current trend and swept along by a wave of nostalgia,



it becomes fashionable again and everyone calls it timeless. It would seem, therefore, that the only way to be timeless is, in actual fact, to be time-specific. An example of this is chalk typography. Maligned for years as a style reserved for cheap public houses, chalk typography now appears on craft beer packaging and trendy burger joints. Whereas artists in the past had to suffer the excruciating scraping sound of the chalkboard (even writing about it makes my back teeth clench up), we can re-create this classic style in Photoshop. So before it falls out of fashion again, let’s get started!



OUR EXPERT ANDY HAU



www.andyhau.com @andykwhau I am a London-based architect and designer and the owner of A.H.A Design. For me, design is an escape from the futility of modern life, not an endorsement of it.



SOURCE FILES The files available on the website include the blackboard background and a crumpled paper texture for the chalk effects. The fonts used are either standard stock fonts available on most computers or royalty-free fonts available from sites such as www.dafont.com



BACKGROUND ELEMENTS
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CREATE THE BACKGROUND



Create the chalkboard background by dragging the chalkboard texture into the middle of the canvas. To fill in the empty areas, use the Magic Wand (W) to select the areas you want to fill and then select Content Aware Fill (Edit>Fill). Photoshop will magically fill in these areas using the current image.
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ADD A BORDER



Draw the outlines for each element in Adobe Illustrator or by hand and bring them into Photoshop separately so that you can adjust the composition of the piece and control the chalk effects one by one. Begin by bringing the border into the canvas. This should be a simple shape so that it doesn’t draw too much attention.
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BACKGROUND ADJUSTMENTS



The Content-Aware Fill tool will normally create a fairly seamless fill. However, there may be areas that you’ll need to tidy up by using the Clone Stamp tool (S). Hold Opt/Alt and click the left-hand mouse button to select the area that you want to clone and then left-click again over the area that you want to be hidden.



WORK IN PROGRESS



CREATE DIGITAL CHALK TYPOGRAPHY



Fonts: Nymphette.ttf (www.dafont.com/nymphette.font): Lauren Thompson, Lobster 1.4.otf (www.dafont. com/lobster.font): Paolo Impallari Textures: Chalkboard.jpg (www.flickr.com/photos/alicegop/13318243535): Alice Keeler, CrumpledPaper.jpg (http://tinyurl.com/kfo85v3): John Ott



SET THE SCENE FOR YOUR IMAGE



Progress 1: Create the



blackboard



Progress 2: Chalk effects



Progress 3: Finishing touches
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TECHNIQUES CREATE CLASSIC TYPE
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DRAW THE FIRST BANNER



Flowing banners add dynamism and a sense of eccentricity to the image, which will not only help to make the image look more interesting but also more convincing. Select the areas of shading and highlights on the banner by using the Polygonal Lasso (L). Cut these areas out (Cmd/Ctrl+X) and paste (Cmd/Ctrl+V) them onto a new layer. Double-click the layer and select the Color Overlay tab. Choose a cool, receding turquoise colour (such as #71C5C5) to bring the banner to life.
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ADD SOME TEXT



Since the banner is curved, a cursive font such as Lobster is required for the text to help with the flow of the image. You can construct the arched text using Adobe Illustrator’s Type On A Path tool, or alternatively you may prefer to hand-draw it. Once you’ve brought the text into the canvas, use the Magic Wand (W) to select the spaces within the letters. Delete the areas of the banner that appear inside these letters.



CREATE DEPTH



Adding depth to the letters will make them stand out more and make them more legible. Make a copy of the text layer and place it behind the existing text layer. Move the copied layer slightly to the right of the existing text to create some depth. Double-click on the layer and select the Color Overlay tab. Choose an advancing orangey-gold colour (such as #E7B566) to really highlight the text. Finally, select the spaces within the letters using the Magic Wand tool (W) to delete anything unnecessary.
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MORE TEXT



For the word ‘JUMP’, use a bold serif font to help embody and capture the meaning of the text. Arch the top of the text so that it slots seamlessly underneath the banner to create a more streamline appearance. This can be created in multiple ways: in Adobe Illustrator, you can use the Arc Upper Warp (Effect>Warp>Arc Upper); in Adobe Photoshop, you can use the Warp tool (Edit>Transform>Warp). Add lines inside the text to create a bevelled appearance, which will help to bring depth to the image.
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DEFINE THE PATTERN



To create a chalk effect fill, open up the crumpled paper texture in a new window. Go to Edit>Define Pattern and give the pattern a name to save it. Go back to your working canvas and select all the bevelled segments in the ‘JUMP’ text that you want to be highlighted using the Polygonal Lasso tool (L) or Magic Wand tool (W). Create a new layer behind the ‘JUMP’ text layer and fill the boundaries in white using the Paint Bucket tool. (G). QUICK TIP All outlines in this tutorial are created using the chalk brushes in Adobe Illustrator. Unless you have a graphics tablet and an endless supply of patience (I possess neither), I would not suggest trying to re-create the outlines in Photoshop – it will take a lot longer and you won’t get a very convincing effect.
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CHALK WITHOUT THE MESS



CREATE AN EASY BUT EFFECTIVE CHALK EFFECT
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FUSE FILLS



Once you have filled the boundaries in white, double-click on the layer and select Pattern Overlay. Select the crumpled paper pattern that you defined in step 8 and press OK. Ctrl/right-click on the layer and select Rasterize Layer Style. Go to Filter>Noise>Add Noise and change the Amount slider to approximately 35, or whatever you think is appropriate.
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ENHANCE THE FILLS



Turn down the Opacity of the layer with all of the fills to help blend them into the chalkboard background. Select the Eraser tool (E) and choose the Spatter Brush in the brush settings, changing the size of the brush to suit the size of the fills (approximately 150px). Lower the Opacity and Flow settings for the Eraser to approximately 25% and 35% respectively, then gently delete some of the fills to create an uneven and smudged chalk effect. Lower the Opacity of the layer further if necessary.



It would seem that the only way to be timeless is to be time-specific



001



001 TEXT



The text was modified so that it fits comfortably under the curved banner, creating a more streamlined appearance
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002 HIGHLIGHTS



A crumpled paper texture was defined as a pattern and then modified to create the fills for the highlights



SECOND BANNER



Since the bottom edge of the ‘JUMP’ text is straight, the second banner needs to be more geometric. It is the tension between these straight edges and the organic nature of the cursive text and flourishes that will bring this image to life. For the ‘Dozy Fowls’ text, choose a bold serif font such as Copperplate to match the linearity of the banner. Give the text a black outline by double-clicking the layer and selecting Stroke. Finally, give the text some depth by following step 6.



12



003 ENHANCE



The white fills will be further modified to create a more convincing chalk effect using the Eraser (E)



THIRD BANNER



For the third banner, a more organic and laid-back approach is required in order to complement the first banner and contrast with the second, thereby creating a complete composition. Much like step 4, select the drape lines on the banner by using the Polygonal Lasso (L). Cut these lines out and paste them onto a new layer. Double-click on the layer and select the Color Overlay tab. Select the orangey-gold colour for these lines to help bring depth to the banner.
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QUACK!



Again, to express the meaning and humour behind the text, a cursive font such as Lobster is required for the word ‘QUACK’. To make the text as bold and loud as possible, fill it in with a chalk fill effect using the process described in steps 9 and 10. For depth, copy the layer and place it behind the ‘QUACK!’ text layer. Double-click on the copied layer and apply a Stroke layer style in gold and a Color Overlay in black.
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TECHNIQUES CREATE CLASSIC TYPE



DRAWN TOGETHER



BRING TOGETHER THE FINISHING TOUCHES
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DRAW BOWS



For a bit of quirkiness, create two bows to support the third banner. Create the chalk fills in a similar way to steps 9 and 10. However, once you’ve got the chalk effect the way you want it, create a new Photo Filter adjustment layer by clicking on the round icon in the Layers panel. Place the adjustment layer directly above the layer with the bows, Ctrl/ right-click on it and select Create Clipping Mask. Fill the adjustment layer with the turquoise colour to change the colour of the chalk fill.
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DATE OF ESTABLISHMENT



Much like the crown, a date of establishment often makes the brain believe something is older than it actually is at first glance. Use a bold serif font such as Copperplate to create the date using the Text tool (T). It doesn’t really matter what date you put in – I’ve used 2014 mainly because I like the feeling of anachronism and absurdity, but if you really want to trick the viewer, use an older date. Lower the opacity of this layer slightly to help it blend into the blackboard.



CLARITY VERSUS FEELING When it comes to typography, there is always a battle between the clarity of the text versus the overall feeling you want to convey. In chalk typography, unless you are using it to sell a product, the legibility of the text almost comes second to the emotion you are evoking. Chalk typography is graceful, dynamic and intricate, which should be celebrated and not apologetically leashed. Of course, make sure that your text is legible at closer inspection, but at first glance, the viewer should be bowled over by power of the flowing text, not necessarily the meaning behind it.
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SLEEPING DUCKS AND JUMPING FOXES



Introducing small illustrations will help to add to the illusion that this piece has been created using real chalk. Use the Polygonal Lasso tool (L) to create silhouettes of a jumping fox and a sleeping duck and follow steps 9 and 10 to create the chalk effect. For the purposes of association, place the fox above ‘Bright Vixens’ and the duck below ‘QUACK!’. For the duck, add some ‘Zzz..zzz’ using the Type tool (T) to indicate he is sleeping. Manipulate the ‘Zzz..zzz’ using the Warp function (Edit>Transform>Warp).
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CREATE A CROWN



Using chalk brushes and effects is not enough to fool the viewer into believing that this image has been created in chalk. The viewer also needs to be bombarded with subtle mental association triggers in order to trick the brain. People often associate the idea of monarchy with history, and so by placing a silhouette of a crown at the top, it automatically makes the image ‘feel’ older than it is. Create the crown as per step 15 and change the colour of the chalk by following step 14.
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LARGE FOX



One of the great things about classic chalk typography is that the more you look at it, the more it reveals. While the words are no doubt the star of the image, create some secondary interest by placing a large fox in the bottom right of the image. Make sure that the lines are free flowing and that they do not connect; the rougher you make the lines, the more convincing they will appear. Change the highlights to an orangey-gold colour by following step 12.



QUICK TIP Classic chalk typography is typically monochromatic. The problem with this is that it can often end up feeling a little flat. By introducing a receding colour (such as blue) and an advancing colour (such as orange), you will add depth, making the image will feel more dynamic and spritely.



19



LARGE DUCK



To balance out the large fox in the bottom right-hand corner, create a large duck in the top left hand corner. Much like the fox, keep the lines as flowing and sinuous as possible to create a feeling of movement. This will help to guide the viewer where to look and where to start reading. Use highlights near the edges to give dimensionality to the duck. Change the colour of the highlights to the turquoise colour by following step 12.
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BLUE FLOURISHES



To add depth , some of the swirls need to be strategically changed to a receding turquoise colour. In a balanced manner, use the Polygonal Lasso tool (L) to select swirls across the composition that you feel need to be toned down. Cut and paste these swirls onto a new layer and change the colour by double-clicking on the layer and selecting Color Overlay. Make sure these swirls are equally spaced out to avoid creating large areas of receding colour, which will make the composition seem ‘hollow’.



QUICK TIP Whilst it’s important to make sure that the composition of your text is well constructed, spending too much time aligning everything will make this type of typography seem stiff and unconvincing. Instead of fretting about how it all lines up, embrace your inner slob and go with what feels right!
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ADD FLOURISHES



Swirls and flourishes not only add drama to the image but also help to direct the eye to other parts of the composition. You can create these flourishes by hand or in Adobe Illustrator. However, the easiest and most effective way is to use a font called Nymphette, which includes a series of beautiful swirls and flourishes. Position and size the swirls so that they flow effortlessly from and to each other, making sure that the gaps in between are approximately equally spaced.
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EXPLOSION LINES



Finally, to turn the feeling of dynamism up to full volume, add explosion lines that lead from the centre of the image to the inside edge of the border. This technique will help to fill in some of the empty spaces in the composition and gives the image maximum impact. Make sure you break the lines with the Eraser (E) at the points where the exploding lines intersect with the banners, text and swirls. This will help to frame these elements and maintain their legibility.
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GOLD FLOURISHES



Changing the colour of the top and bottom swirls will help to ‘contain’ the text and make them the focus. If you’ve used the Nymphette font to create the swirls, make sure you rasterise the layer first by Ctrl/right-clicking on the layer and clicking Rasterize Layer. Select the swirls at the top and bottom of the composition using the Polygonal Lasso tool (L) and cut and paste them onto a new layer. Change these swirls to a gold colour by double-clicking on the layer and selecting Color Overlay.
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ZOOM OUT



Zoom out using Cmd/Ctrl+0 so that the entire image fits onto your screen. Check that you are happy with the composition of the image. The position of all the objects should appear balanced and there should be a natural ‘flow’ that leads the eye from the start of the sentence to the end and then to the other parts of the image. Make sure that the areas of colour are balanced and help with the flow of the composition rather than detract from it.
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© Carolina Rodriguez Fuenmayor



TECHNIQUES HOW I MADE



HOW I MADE



PRIMAVERA ISLE



CAROLINA RODRIGUEZ FUENMAYOR



THIS ARTIST SHOWS HOW SHE TURNED THE DISAPPOINTMENT OF A DROPPED COMMISSION INTO A HAUNTING AND ATMOSPHERIC WORK OF ART



C



arolina Rodriguez Fuenmayor (www. behance.net/alterlier) initially started work on this image as a poster for an agency, but the commission was called off in the early stages. However, the artist decided to pick up the artwork again and turn it into a creation of her own. She explains the initial concept and how she



01



progressed it: “The [original] idea was around liberty and fun, Woodstock and music. When [the agency] rejected my work, I decided not to waste it, but to transform it into something else. I wanted to do a really colourful, fairytale atmosphere, like something coming out of a Grimm’s fairytale.” Fuenmayor starts her images out as a quick sketch, and then in



Photoshop the background is painted, first using plain colours or gradients: “I really like gradients; they are not the fanciest thing, but it gives me a nice idea of the palette I could work with.” She will then draw lines to get the composition right, before cleaning them up and adding colour. Read on to find out more…



INITIAL SKETCH



This was the first sketch I sent to the agency – just quick lines. I like red when I’m starting and if there is a sky involved in the image, I love to design the clouds first.
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REVISIONS



They didn’t like it; they wanted a central piece with the air balloon in the middle. At this point I was kinda angry, so I decided to do a sketch they couldn’t reject with clean lines and a brighter palette.
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CHANGE OF PLAN



They liked it, so I started playing with colours, a basic palette, no detail – just trying to get my eyes used to these combinations. [However, the commission was called off.]
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TECHNIQUES HOW I MADE
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RESTART



I saved the project away for about two months. One day I was bored and I didn’t want to start anything new, so I grabbed it again, with a plain colour on the background and different lines.
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05



I started with blue and purple, and from there I almost painted everything on the same layer real fast. I kept the line, but it wasn’t working at that moment so I kept it hidden.



MAIN CHARACTER



The main character is actually just a shape without shadows or light spots. I have problems using light sources, so what I do is to use light wherever I want! I also added some dust.



COLOURING IN



CONCEPT



I knew that I wanted people walking to an unknown place and I knew that the main character was late. It was [about] just getting out the woods and going for freedom, or something like that…



I really like gradients; they are not the fanciest thing, but it gives me a nice idea of the palette I could work with
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FINAL LINES



I had my lines, but they weren’t working. I started playing around with the Hue dialog and for some reason I set the light to maximum. I did some adjustments with Color Balance to finish.
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COLOUR INSPIRATION FUENMAYOR TELLS US HOW SHE USES COLOUR PALETTES FROM OTHER IMAGES TO INSPIRE HER WORK Search for images you like and use their palettes. There are so many colour combinations that sometimes you don’t know how to use them. I often start with the palette of another image and while working, I start to make changes. Sometimes they end up being completely different from the initial colours, but it makes my workflow easier.



SAVE RHINOS NOW 10% OF OUR PROFITS HELP FIGHT POACHING



An animal in crisis



In eastern Africa, poachers use automatic weapons to slaughter endangered rhinos. The animals are shot and the horns are hacked away, tearing deep into the rhinos’ ﬂesh with the rhino left to die.



Make a difference today



Ol Pejeta is a leading conservancy ﬁghting against this cruelty. It needs more funds so more rangers and surveillance can be deployed on the ground to save rhinos from this horrible treatment.



Join World of Animals



World of Animals magazine tak stand against these atrocities an is proud to be in partnership with the Ol Pejeta Conservancy – 10% of our proﬁts go towards saving rhinos in the ﬁght against poaching



BUY TM



AND HELP FIGHT POACHING



Buy World of Animals at all go worldofanimalsmag



@WorldAnimalsMag



@



animalanswers.co.uk justgiving.com/olpejeta



OUR EXPERT BRANDON CAWOOD



www.brandoncawood.com @Brandon_Cawood Brandon Cawood is a commercial and advertising photographer from Georgia, USA. He specialises in high-energy composites and does his own retouching and Photoshop work.



SOURCE FILES Check out the tutorial files online for images to try this manipulation out for yourself. The other image is from http:// tinyurl.com/mw63jow and the fog texture package is from phlearn.com.



PHOTOMANIPULATION



SCIFI CITYSCAPES



LEARN TO COMBINE CITYSCAPE ELEMENTS WITH RURAL LANDSCAPE ELEMENTS TO CREATE A FUTURISTIC BLADE RUNNERSTYLE SCENE



M



any of us long for the challenge of creating a world that only exists in the mind of the creative. This tutorial outlines the basic techniques to reach that desired outcome, but will take a good deal of experimentation and trial and error to get it just right. It is for those with a solid foundation and
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understanding of adjustment layers, blending modes and masking techniques. The idea here is to take multiple elements from different landscape images and create something that only exists in the imagination. For this particular image, you will be creating a futuristic cityscape emerging from a rural sunset scene. This image is very much inspired by



the movie Blade Runner and other movies of its kind. Lighting effects and atmosphere play a huge role in the mood and feel of this image. Follow along with the tutorial as it guides you through the basic principles of each step. Hopefully this will inspire you to create worlds of your own, and maybe you will even learn something new!



SCIFI CITYSCAPES TECHNIQUES



TECHNIQUES SCIFI CITYSCAPES



WORK IN PROGRESS



FROM RURAL TO FUTURISTIC



Progress 1: Place your elements



Progress 2: Masking and



perspective



Progress 3: Add light effects
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CONCEPT AND GATHER



When trying to pull off any photomanipulation, proper planning is essential. Planning gives you a starting point. A simple sketch is all you need. Having a sketch will allow you to explain your vision to your talent or client and allow you to remember all your brainstorming ideas. Think about the angle, the perspective, where the light is coming from, and any other details you want to remember. It doesn’t have to be a work of art. Once you have a concept, you can gather the elements for your image.



PERSPECTIVE



If you are using stock images or images taken at different times, the perspective on each image may be different. You want to use images that have similar visual perspectives. You don’t want to use an aerial city shot with one taken from a low angle, as the perspectives won’t match. You can adjust perspectives that are slightly off by going to Edit>Transform>Perspective. By clicking and dragging on the corners, it will adjust the perspective of the photo. There are several perspective tutorials online for more detailed information on this technique.
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MASKING, CLONING AND CURVES



When you are working with landscapes, use the natural lines to your advantage. Try masking things in and out on the horizon. It is always a good idea do to any cloning on a separate layer in case you make a mistake. Use Curves adjustment layers clipped to your layers to adjust the colour temperature and exposure of each element so that they blend with each other. You can also use Levels adjustments to add shadows and highlights to make sure they all match within the final image.



PLACEMENT



To get an idea of whether your concept is going to work the way you have planned, you can do a quick mock-up. For this step, take all of your elements and place them in their intended places on separate layers. It may be necessary to do some quick masking so you can see layers underneath each other. Try to line up the horizons of each image if possible. Make sure you use a layer mask on each layer. You don’t want to permanently erase something you may need later.



You don’t want to use an aerial city shot with one taken from a low angle. The perspectives won’t match
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BILLBOARDS



By using a photo that already has signage, you already have a template to place your billboard images. Paste your image in a layer above the underlying signage. Go to Edit>Transform>Distort. Now you can place each corner of the image on top of the corners of the underlying billboard. Be sure to use portrait crops on tall billboards and landscape crops on long billboards. If there happens to be a curve around a corner, like this image, while still in Transform mode, Ctrl/right-click and select Warp. Warping will allow you to curve the edges where you need to.



QUICK TIP Make sure you save your project often. This will keep you from losing hours of valuable time on a project. If you get to a point where you want to try something that may or may not work, save your document first. Then click File>Save As and name it something else. This way you aren’t working on the original file and can always go back to it later.
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ATMOSPHERE



A good way to give a composite like this one some depth is to create some atmosphere. To do this, establish a foreground, midground and background. You can use an image of fog on a black background to create the atmosphere. Be sure to change the blending mode to Screen. You can adjust how thick the fog is by using a Levels adjustment layer. Make sure the adjustment layer is clipped only to the fog layer so it doesn’t affect the rest of the image. Place varying amounts of fog in the foreground, midground and background for a more realistic look.
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FLYING CARS



The flying cars in this image are very simple. Because they will have so many lighting effects added to them, they don’t have to be super detailed. You can create the basic shape and colours with the Brush tool and then use the Smudge tool to blend them together. Be sure to put light colours anywhere a lighting effect will be added. You can duplicate the layer when you are done and change the scale to create multiple cars by hitting Cmd/Ctrl+T to transform. Be sure to hold Shift while you drag a corner in or out to keep the dimensions the same.



COLOUR GRADING



Add a Color Balance adjustment layer. The colour balance adjustments will vary from image to image, so play around with them to get the look you want. For this image, the shadows and midtones were pushed towards the cyan and green tones to create teal, while the highlights were pushed towards the red and yellow tones to create orangey yellow. Sometimes, using a Color Balance adjustment on top of another Color Balance adjustment can give you different looks. Just don’t push it too far or you will risk losing details in your image.
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LIGHTING EFFECTS AND NEON



Adding lighting effects not only enhances the image but also helps blend all the elements together. Photoshop has built-in flare effects and there are also third-party plug-ins. For the neons, make your lines with a white hard brush and then go to Layer>Layer Style>Blending Options. Select outer glow and inner glow. Set the blending mode of both to Screen and adjust the size and spread as needed. Also choose a rounded contour. Clip a Hue/ Saturation layer to your neon layer to change the colour of the neon. Select Colorize and use the Hue and Saturation sliders to get your desired colour.



ADD GRAIN FOR BLENDING



Lastly, add grain. Create a new layer above your sharpened image. Hold down Shift and hit Delete. Choose ‘Fill with 50% gray’. Change the blending mode of this layer to Soft Light. Next, select Filter>Noise>Add Noise. The size of your image will determine the Amount you use. Choose Uniform and leave Monochromatic unselected. Once you apply, hold down Cmd/Ctrl+U, then pull down the Saturation to -85%. Leaving a little colour in the grain will make it look more natural. Be sure to do this step at 100% zoom. You can adjust the Opacity if it feels like it’s too much. Save your PSD.
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HOW I MADE



SPACESHIP WRECK YARD



MACIEJ WOJTALA WE TALK TO THIS DIGITAL ARTIST TO FIND OUT HOW HE CREATED THIS NEW TAKE ON A CLASSIC SCENE



A



digital artist usually working on in-house and freelance concept art, Maciej Wojtala (wojtala.com) has worked on some amazing projects such as Gears of War: Judgement and Bulletstorm. For Spaceship Wreck Yard, Wojtala’s initial idea was simply to take the very popular theme of a wrecked spaceship, and see where his artistic abilities could take it. “Also, I was tired of depressive sci-fi scrap yards and wanted to create something cheerful – an environment you want to explore and spend time in,” he reveals. “The biggest challenge was to make all the elements come together; make it look unified and real. Also, at that time I used a lot of aerial perspectives for work, and wanted to use the technique here. It is time-consuming but the outcome can be vast, epic and helpful for a game artist. I also watched a lot of Star Trek and wanted to create something that might exist in that universe. Throughout the process, I used Photoshop, a few photo textures, a lot of custom brushes and my Intuos drawing tablet.”
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EXPERIMENTATION



First, fast sketches were the best way to develop the idea. While doing them, it was the perfect time to think about composition, design and mood, and solve as much as I possibly could.



© Maciej Wojtala



TECHNIQUES HOW I MADE



The biggest challenge was to make all the elements come together; make it look unified and real
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DESIGN



After a few initial sketches, the idea developed. I felt the environment should consist of different spaceship wreckages scattered from different timelines throughout the landscape. It was at this time that I began to work on the design of the main spaceship.
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FINAL TOUCHES



At this point I decided to change the mood, make it more humid and introduce colder blue and green colours. To add in a sense of time, I wanted to show that some of the spaceships crashed here a long time ago and are a part of the hills now.
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LOWPOLY PORTRAITS TECHNIQUES



ILLUSTRATION



LOWPOLY PORTRAITS CREATE A LOWPOLY ILLUSTRATION BY COMBINING PHOTOSHOP AND ILLUSTRATOR FOR PIXELPERFECT RESULTS



L



earn how to create an amazing low-poly illustration from a reference image with this tutorial. Combining Photoshop and Illustrator will allow you to achieve the sharpest, most accurate results. This will work with almost any version of Adobe software, and with other programs too (so if you don’t have Illustrator, you can try a free vector program such as Inkscape). The technical side is very basic and the real challenge of this technique is patience.



This effect could be created in Photoshop alone but I find Illustrator easier to handle, as it offers greater precision with vector shapes. Try to understand the whole concept and then choose the tool that is best for you. There are some scripts and plug-ins that create polygons automatically, but they will NEVER be half as good as doing it manually. An algorithm can’t see how a tiny white poly in the pupil can make the whole piece look ‘alive’; no script is better than the human brain. So trust yourself and let’s get this tutorial going!



PREP THE START PHOTO SELECT THE RIGHT IMAGE



The reference image should be a high-quality photo. Try to find an image with a strong colour point (like the hair in the photo below). The best kind of image for this technique is a portrait, and one that has a very clear view of the eyes. You will need to zoom in, so pick a high-quality image.
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www.mordilevi.com @mdlv123 www.facebook.com/MordiLevi.gd Mordi has been a graphic designer and illustrator for the past six years. He specialises in branding, various Illustration techniques, web design and more.



SOURCE FILES
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OUR EXPERT MORDI LEVI



ADJUST CONTRAST AND SATURATION



Drop the image into Photoshop. Adjust the Brightness and Contrast levels. You should aim for a high contrast to make the grid-creation step easier. Add more saturation and make the colours bright, but not too much. Do not change Contrast, Brightness or Saturation to higher than 30%; it needs to be sharp and bright, but not overly so!



Download the start photo from http://www.dreamstime.com/ stock-images-portrait-beautifulyoung-redhead-womanimage10778824.



WORK IN PROGRESS



&2/-ď0(/4/ď4/ď,/7˶0/,9ď ILLUSTRATION



Progress 1: Creating the grid



03



REDUCE QUALITY



If the image is really high in quality, reduce it so that the maximum height/width will be no more than 1000px. Later on when you will need to colour the polygons, It will make it easier to sample the colours while zooming in – you will see the actual pixels and their colour, which will make it easier to choose and more precise.



Progress 2: Creating the



polygons



Progress 3: The colouring



process
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TECHNIQUES LOWPOLY PORTRAITS
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WORK IN LAYERS



At this stage you can drop the image into Illustrator. Remember to work in layers. Create one layer for the photo, above it create another layer for the background colour and above this, the polygon grid. You can add more layers later on as you wish, but this is mandatory because you will have to turn these layers on and off during the tutorial.
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CREATE THE COLOURED BACKGROUND



Low-poly illustration is very busy with details, so you should create a clean background with a minimal gradient effect. I have found it best to create the gradient from the image’s actual background because it affects the colouration of the skin tone, hair etc. Select two tones from the background and make a gradient. Keep it minimal! If it’s hard for you to notice the gradient, then it’s good.



CHOOSE THE LINE



Next you will start creating the grid. Choose the Line tool from the Toolbar and change the colour to a bright yellow. This is a good colour to contrast against most other colours, so you can see what you are doing. Change the Stroke to 0.5pt width. In Photoshop, you can use the Polygonal Lasso.
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START WITH SMALL AREAS



The best way is to start with the eyes. Zoom in as close as you can to the iris, and re-draw it with the Line tool. This is just like using the Polygonal Lasso tool in Photoshop (so you can use that if you don’t have Illustrator). There is no need to be very accurate, just draw the general shape. Keep working on the parts of the eye separately and connect them to one another. In the end this will be one big connected grid.
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ISOLATE THE PARTS



Work one part at a time. Take the nose, and split it into dark and light parts. Work on one eye and then another. Zoom in if you need to, and try to keep the lines connected to each other as much as possible. There should not be any loose ends – the shapes should all be closed. QUICK TIP A good way to move around is using Cmd/ Ctrl+Plus and Cmd/Ctrl+Minus to zoom in and out, and pressing the Spacebar to move the artwork. Zoom in for smaller parts and out for bigger ones. Don’t work on big parts while zoomed in; you’ll need to move around a lot, which will make this longer and harder. Use Cmd/Ctrl+Y to see what you have created – it will keep you motivated!
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During the process you will have a lot of lines that don’t connect. Leave them alone! Messing with them will keep you distracted from the main issue – understanding how to take an image and cut it to pieces. Later on you will go back and fix the connections.



One of the most important parts in the illustration is the light inside the iris; this will give a lot of heart to the image. Keep polying!
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MAKING PROGRESS



This is a very long process, so you should take a break once you get the whole image lined up into pieces. The next part is harder and this is normally the part where people give up. Take a break!
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SPLIT HAIRS



For most portraits, the hair is the challenging part. You should try to split the hair into locks, or big strands of hair. This doesn’t have to be perfect, just try to capture the direction of each strand and where it intersects with another.
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CONNECT THE LINES



Later on you will transform this grid into a Live Paint object, and any loose ends will be a problem. So, you should go over the grid you have created and connect the lines. There is no need to join them together – just put a dot on the other end so there is no gap in between them.
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START POLYING!!



Now this is the fun part. Again, start with the smaller objects like the eyes. Zoom in and start creating triangles. The triangles should be created from the corners or intersections of two lines. Remember that this is a tiny part of the illustration, so if the polygon gets too small just skip it. It will not show at 100%. One of the most important parts in the illustration is the light inside the iris; this will give a lot of heart to the image. Keep polying!
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TECHNIQUES LOWPOLY PORTRAITS



MAKING THE POLYGONS



CREATE THE POLYGONS AND GET COLOURING
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BALANCE THE POLYGONS



Start with the small parts, finish them and than move on to the big parts. This way you can connect the parts together and keep a variety of sizes. There should be a contrast in sizes, from extra-small polygons like in the eyes to big polygons in the cheeks, forehead and clothing. This makes the artwork far more interesting and diverse.
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REMOVE THE OUTLINE



Once you are finished with the colouring process, select the artwork, go to the stroke colour in the Toolbar, and select ‘None’ to remove the stroke from the illustration. Go back to the illustration and try to find polygons that you didn’t colour. It helps to put a white background behind the illustration; if you have a lot of white polygons in it, use a black background. The contrast will make it easier for you to spot uncoloured polygons.



STAY FOCUSED Like I said, the technical side of this illustration is pretty much straightforward, the hard thing is not giving up, not making shortcuts and staying focused. If you need more guidance, have any questions or would like to see some more of my low-poly illustration process, you can contact me via facebook on www.facebook.com/MordiLevi. gd. Thank you for reading!
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CONVERT TO LIVE PAINT



Congratulations! You finished the grid! The hard part is behind you. Now select the entire grid (watch that you are not selecting the background too) and go to Object>Live Paint>Make. Now you can colour the grid with the Live Paint Bucket. In Photoshop, you can create a Smart Object.
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START THE COLOURING PROCESS



Zoom into the eye, sample the colour from the photo with the Eyedropper tool (I) and then colour the polygon with the Live Paint Bucket tool (K). In Photoshop, simply use the Paint Bucket.. You should be jumping back and forth between the (I) key and the (K) key, sampling and colouring, one polygon at a time. DO NOT click the Bucket when the cursor is on the stroke – it will colour the whole illustration. This happens sometimes, and if it does, just Cmd/Ctrl+Z and move on. Use the Spacebar to move around. Once you let go, it will go back to the previous tool. You can toggle the background layer to see the progress that you’ve made.



MAKE IT YOUR OWN!



This is it! You have done it! Now you have an amazing low-poly Illustration. The next step is customising it. Maybe break some polygons off the edges, make parts of the grid visible, alter some colours here and there. Drop the final artwork into Photoshop and play around with it. Make it your own!



QUICK TIP To re-create the breaking polygons effect, select the artwork and go to Object>Expand. Ctrl/right-click the artwork and choose Ungroup. Repeat the Ungroup command until the polygons are separate, then you can play around with them. Remember to make a copy in case things go wrong.



BUILD A BETTER WEB www.webdesignermag.co.uk



Available from all good newsagents and supermarkets



ON SALE NOW



Perfect web apps | Pick the best type | Drag and drop with HTML5 PRACTICAL TIPS



BEHIND THE SCENES



INDUSTRY OPINION



BUY YOUR ISS Print edition available at www.imagineshop.co.uk Digital edition available at www.greatdigitalmags.com Available on the following platforms



facebook.com/webdesignermag



twitter.com/webdesignermag



OUR EXPERT PAUL SCOTT CANAVAN



www.paulscottcanavan.com @abigbat Canavan is the art director at Scottish indie game studio Blazing Griffin, and a freelance illustrator when he gets a spare minute.



DIGITAL PAINTING



REAL PAINT EFFECTS IN PHOTOSHOP CREATE A FANTASTICAL DIGITAL ILLUSTRATION USING TRADITIONAL PAINTING TECHNIQUES



T



raditional paintings are exciting. They evoke energy, texture, dedication and passion. Through this tutorial, you’ll learn how to paint an exciting fantasy illustration using only Photoshop, a graphics tablet and some imagination. No paint mess, turpentine spillage or sitting around waiting for your canvas to dry, just textured strokes and well-thought-out, bold colour choices that make people go “ooh”. Using reference correctly is one of the keys to becoming a successful artist, and something we’ll cover in this tutorial. Through studying the
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fundamentals, in particular composition, anatomy and colour theory, you can expand your visual libraries and improve the ideas you put down on paper. In order to prepare for a new painting, you should first research the topic; find images that relate to the subject matter and study them. Treat them as a resource to examine whenever you get stuck or need to reference directly. Before you begin, grab some images of paintings you like and look at how the artists applied paint; that’s what you want to emulate here.



REAL PAINT EFFECTS IN PHOTOSHOP TECHNIQUES
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TECHNIQUES REAL PAINT EFFECTS IN PHOTOSHOP



WORK IN PROGRESS



FROM SKETCH TO POLISHED PAINTING



Progress 1: Getting started



02 Progress 2: Painting details



from reference



Progress 3: Finishing touches
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COLLECTING REFERENCES



Start by collecting references. These can be photographs relating to aspects of the image, for example skies, landscapes and waterfalls, or paintings that match the mood you want to create. Because we’re going for a traditional look here, you could include work by painters such as John Singer Sargent, Thomas Cole and modern artists like Jaime Jones. Create a new document in Photoshop and simply drag your references in, arranging them to your liking. Save this file to refer to later.



In traditional painting, artists sometimes create an underpainting as a base for subsequent layers of paint. This technique applies nicely to digital painting; if you allow breathing room between your strokes, you’ll get some of that colour and texture showing through. Create a new document at A3 size. Choose a colour that contrasts with your palette; in this case we used blue tones. Grab your favourite textured brush and start loosely filling the canvas! There’s no need to be clean here – you want those imperfections.



Take your time and really think about each stroke you are applying
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SKETCH!



Having spent some time absorbing your reference images and scribbling in a notebook, you should have a good idea of what you want to draw. Create a new layer above the underpainting and get scribbling. Think about the composition; you want to lead the viewer’s eyes through the painting. The best way to do this is to use lines that lead directly to the focal point, in this case the mountain, and to use colour and value contrast to pop it out. Don’t worry about being clean and careful, as you’ll be deleting this layer later!
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CREATE AN UNDERPAINTING



START PAINTING



Choose a textured brush and reduce the flow to around 50% – this will apply less ‘paint’ with each brush stroke. Take your time and really think about each stroke you are applying; you want to leave some spaces between marks to let that lovely underpainting show through. Colour choice is important, as it’ll help drive the viewer through the image. The sky defines the palette of the whole painting, so paint that with yellows, oranges and other warm colours, while the rest of the image will take on some colder blue tones.



QUICK TIP Learn layer masks! Masks allow you to control transparency simply by painting in black and white. They’re great for adding texture, blending layers or making adjustments that don’t affect the whole image. Instead of using the Eraser, just go to Layer>Layer Mask>From Transparency and experiment… you won’t go back!
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FOCUS ON BIG SHAPES



At this stage of the painting you don’t want to get caught up in details. By focusing on big shapes you’ll be able to cover the canvas quickly, which makes it easier to see if the composition and values are working. Use big brushes when you are blocking the forms in, around 300 pixels plus at times! Don’t be afraid to make mistakes, as you can still use Photoshop’s toolset to help you out here (the Eraser is your friend, but remember to switch the default brush it uses to a textured one!).



08



06



LIGHT AND RENDERING



With the painting blocked out, you can start to think about how light affects the environment. Use the Eyedropper tool (I) to select colours from the sky, then paint highlights where they would naturally fall. A nice balance of shadows and highlights will create interest, so bear that in mind when you paint the rocks. Match your stroke direction to the shape of the object you are painting to enhance the 3D effect: paint mountains with vertical strokes, curve around forms and then move to horizontals when you get to the ground.



USE YOUR REFERENCES



To create realistic, tangible forms in your environment, you can reference photographs directly. To do this, open the reference file you created in step 1 and place the image beside your canvas. Treat sections of your painting as mini studies to help you define areas such as the rocks. Try to learn while you work; pay close attention to the way light and shadows fall over the stone, but bear in mind that this might be different to the palette and lighting you are painting!
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DON’T ZOOM IN!



A good chunk of the hard work is done at this stage, but resist the urge to zoom in and start adding details! Work at 50% zoom or less until near the end; if you start detailing too early it’s easy to lose control of the composition. A strong painting should read and be interesting to look at as a thumbnail image; frequently zoom right out to check the composition is working, or alternatively open a navigator window by going to Window>Navigator in the top toolbar.



COMPOSITION TIPS



This is an example of the flow through the painting. White lines indicate the rule of thirds, a commonly used composition breakdown in which you place items of interest on the lines and in particular where they intersect. You can see in this image that the focal point sits on an intersection and a line, while the character sits dead centre in the lower horizontal. The red lines indicate how the rock shapes are intended to drive your eyes through the painting.
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TECHNIQUES REAL PAINT EFFECTS IN PHOTOSHOP
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ADDING DETAIL



With most of the elements of the painting blocked in nicely, it’s time to focus on individual areas. Bring your attention over to any part of the image you think is lacking and start to render it out. Remember, you aren’t going for incredible detail here, more the illusion of detail; you want to save areas of highest detail for your focal points. Change your brushes frequently to add varied texture to the painting and don’t be afraid to be bold with your strokes.
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CLOUD RENDERING



To paint the clouds, use a hard square brush to lay in the forms in combination with the Smudge tool to soften and stretch the undersides. The mixture of hard and soft edges lends believability and weight to the shapes even though they’re still quite abstract. The Smudge tool can be used for painting rocks and other forms too – experiment with different brushes in conjunction with it! John Silva has some fantastic smudge tool presets available at http://johnsilva.deviantart.com.
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ATMOSPHERE



A nice way to separate the elements of your painting and give the illusion of depth is to add atmospheric fog or haze. Take a large soft brush set to low opacity (10-20%) and select a light tone from the sky. Use this to gently paint in atmosphere behind the rocks to separate them from each other, increasing in thickness as you recede back through the image. Erase or use a layer mask to tidy this layer up when you are finished; less is more.



CHECK YOUR VALUES



Now that you’re nearing the finish line, it’s a good time to check your values – essentially to look at the image in black and white so you can see how well it reads. Go to Layer>New Adjustment Layer and select Hue/Saturation. Slide the Saturation slider to -100. Remember – you want your focal point to pop out, so increase the contrast in those areas using the Dodge and Burn tools sparingly, or by adding a Brightness/Contrast adjustment layer in the same manner as before. QUICK TIP Take breaks! It’s important to rest your mind every hour or so, both to maintain energy levels and to return to the image with fresh eyes. Often you’ll notice glaring errors when you take even a short break, which you might have missed otherwise.
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CHARACTER PAINTING



Save the best until last – it’s time to look at the characters! Striking the balance of adding detail without ruining the painterly effect isn’t easy, so try to be bold with your strokes and feel out the shapes. Adding little elements like the ball of light, interesting clothing designs and poses will help add story to your painting. Think about who the characters are, where are they going, what this world is. The more thought you put into the designs in your painting, the more exciting it’ll be for viewers.
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FINISHING TOUCHES



Use adjustment layers to fine-tune your painting. Bring the saturation up slightly using Hue/ Saturation and adjust contrast with a Levels adjustment layer. Use the Color Balance adjustment to add yellows (+8) to the highlights and blue (+20) to the midtones; experiment with these settings until you get the overall colour tones you desire. As with the atmosphere, less is more when it comes to adjustments. Apply some Sharpening (Filter>Sharpen>Unsharp Mask) to the final image to pop out some of the texture detail and you’re done!



Learn to inspire www.dphotographer.com



Available from all good newsagents and supermarkets



ON SALE NOW > Tips for night landscapes > Flash techniques > Shoot silhouettes LANDSCAPE TIPS



SHOOTING ADVICE



WILDLIFE PHOTOS



PORTRAIT GUIDES



CAMERA REVIEWS



BUY YOUR ISSUE TODAY



Print edition available at www.imagineshop.co.uk Digital edition available at www.greatdigitalmags.com Available on the following platforms



facebook.com/DigitalPhotographerUK



twitter.com/DPhotographer



REVIEWS LG ULTRAWIDE 21:9 QHD



Stunning quality: A visual aspect ratio of the UltraWide 21:9 provides a heightened sense of involvement in whatever is unfolding, from editing in Photoshop to gaming
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REVIEW



LG ULTRAWIDE 21:9 QHD



AT NEARLY TWICE THE SIZE OF FULL HD, THIS ULTRAWIDE MONITOR IS OUT TO MAKE A BIG DIFFERENCE TO THE WAY WE CREATE  THE ONLY THING HOLDING YOU BACK MIGHT BE A LACK OF DESK SPACE www.lg.com SPECIFICATIONS: mÍÍGLAFCQÍBG?EML?J mÍ ÍVÍ ÍMNRGKSKÍPCQMJSRGML mÍKQÍPCQNMLQCÍRGKC mÍBCEPCCÍTGCUGLEÍ?LEJC



£573 $1,000



I



f not having enough digital canvas is a regular setback when working in Photoshop, then you’ll be instantly grabbed by LG’s 21:9 display. Providing more screen space than you’ll probably ever need, this reasonably priced QHD monitor packs in 1.8 times more panel than a full HD of the same ratio. But does this mean it’s time to finally ditch your existing display and make room for an UltraWide? Well, this is all down to how and what you create. The monitor’s defining feature is, without a shadow of a doubt, its large 21:9 LCD screen, which gleams atop a Perspex stand. The enormity of this monitor only really becomes apparent after lifting it out from the box, and then finding a place for it in



the studio. Working with this wide screen ratio opens up a multitude of creative avenues, such as panoramic photography and video editing, giving you much more visual scope when you are working on bigger projects. In our tests, we ran this monitor as part of an extended setup to an iMac through a Thunderbolt connection, so we were able to utilise the maximum frame rate of 60hz and experience smoother graphics (using an HDMI only produces 50hz). Being Thunderbolt 2-compatible as well gives incredible data transfer speeds of up to 20Gbps – that’s four times faster than USB 3.0. So for increasingly larger PSD and PSB save outs, this is going to be a beneficial addition to your workflow.



Quick off the mark: Connect the monitor via a Thunderbolt cable (left) and enjoy fast speeds and refresh rates for smoother graphical play (right)



Freedom to move: You get a better sense of the image being worked on and the dimensions involved. No more is space an issue while juggling palettes
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REVIEWS LG ULTRAWIDE 21:9 QHD



The monitor is also Mac Pro-ready, meaning that you are able to enjoy its four-screen mode and True Colour Finder straight from the word go. The built-in True Colour Finder and Scaler combine to automatically calibrate colour spaces from a pre-determined set point, independent of your graphics card. This helped us to achieve colour accuracy straight off the bat, whether we were working on photo composites or editing high-def video footage. We were able to see colours working Made to fit: A solid, lightweight and unassuming stand
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to our advantage quicker than on an average monitor that required calibrating at regular intervals. Being QHD, it enables you to work with up to four applications displayed across its panel at any one time, which works as an ideal solution for those who like to multi-task across different applications. But this monitor is all about finding ways to show off, it seems, which brings us to its dual link-up capabilities. This feature makes such an enormous widescreen like this worth owning. Dual link-up means you’re able to connect two devices simultaneously – such as a Blu-ray player and a Mac Pro – which might sound like a great way to impress someone, but in fact proved to be very advantageous. For example, creating matte paintings from references found in a video clip, or just watching a film while editing away in Photoshop, were some of the ways we could get the most of this feature. If you’re an Apple user, then you can also enjoy its four-screen mode and True Colour Finder to give an optimum performance.



QHD VS 4K



WE LOOK AT THESE TWO COMPETING TECHNOLOGIES The latest advancements in screen technology are progressing at an exponential rate, with 4K monitors (including 4K TVs) paving the way for better viewing experiences. Although the resolution of a 4K monitor is more, at around 3,840 by 2,160 – producing fine detail and more screen space than this monitor – the price for 4K could set you back about £2,000/$1,600. This means LG’s UltraWide instantly becomes more appealing on this side of things. But it’s all to do with your desired applications and intended use. A 4K display is most suited to video editing and improved gaming experiences, whereas this monitor by LG is more geared towards Photoshop editing involving multiple applications.



PANORAMIC PLEASURE Let’s begin by answering the question ‘why do we need such a big screen’? If you’ve ever had to work on, say, a panoramic image on a monitor with a standard ratio, then you’ll know exactly how awkward it can be trying to view the entire scene in full frame. Looking at small segments of the panorama and having to physically pan across the canvas to get from one side to the other isn’t the most efficient use of time. But with this monitor, we were able to get a complete view of our panorama composites, allowing us to apply global edits easily and in plain sight. But the advantages of this extra screen space flows into other areas of image editing and design that you’ll likely only realise is beneficial when you own it. Take, for instance, designing a multi-page layout, incorporating elements and assets from different applications such as Illustrator or InDesign, and then having to bring them into Photoshop. The space to have all these applications open is right in front of you and doubles, if not quadruples, productivity.



Size matters: Screen space comes in spades, and the option to have multiple applications running at once is beneficial



It quickly becomes clear that this it not simply a gimmick, or easily ignored for that matter. The overall performance and on-screen image quality, and its general construction, was very impressive. The incredibly thin and lightweight body meant manoeuvring it wasn’t a problem. The only restrictions we found were the lack of a pivoting stand, and with only two height settings we were forced to improvise when it came to squeezing it in the studio. But what we like most about the display is that it’s not all about looks and design. The monitor is prepped for colour accuracy and performance with a number of core features that will be tempting for all sorts of image editors. LG has timed the release of this UltraWide panel just right; releasing it at a time when recent 4K technology is trying to make its own impression. Perhaps this is an option many creatives will prefer over the more expensive and demanding 4K panels. Alongside other panels that offer similar resolutions, but without the same panoramic appeal to match, this QHD monitor is a strong offering.



Link up and edit: The monitor has a HDMI port and DisplayPort, and two Thunderbolt cables



For studio professionals working with a variety of visuals, from still images to HD video, and either editing in Photoshop or in software like Adobe’s Premier Pro or After Effects, having the screen space and resolution to work with is going to be a sure-fire way to improve productivity. Having a wider canvas to play with, and with the potential to have up to four applications active at the same time, makes it worth every penny.



VERDICT Features: 9/10 Ease of use: 9/10 Quality of results: 8/10 Value for money: 8/10



FINAL SCORE:



8/10 083



REVIEWSăăăăCOREL PAINTER 2015



REVIEW



COREL PAINTER 2015



THE LATEST ITERATION OF COREL’S FLAGSHIP PAINTING PROGRAM UPS THE ANTE FOR OTHER DIGITAL PAINTING SOFTWARE
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hotoshop is a great package for digital painting, but sometimes you want something a bit different, especially if you’re looking to emulate the look of real-life paint effects like watercolour or impasto. For this, many digital artists turn to Corel Painter, which specialises in natural media effects. Now in its fifteenth iteration, the software has a history of introducing innovative new features with every release, and this time round is no exception. Where this release differs from its predecessors, however, is in the introduction of a new set of brushes that, unusually for Painter, isn’t inspired by artists’ brush strokes or real media. Instead, the Particle brushes offer a host of creative – but very



aă_ăaă+?Aă-1ă6ă ăLOăFGEFCOăaă5GKBLTPăăLOă definitely digital – effects. They’re inspired by the physical behaviour of particles and they are, quite simply, a concept artist’s dream. They can create spiky little scribbles, randomised strokes and drifts of glowing colour, and are perfect for painting fantasy and sci-fi art, as they produce fiery, magical and crystalline effects. Despite their obviously digital provenance, they still have the artistic spontaneity common to many of Painter’s tools, allowing them to combine perfectly with the more traditional brushes that populate the rest of the program. The rest of the updates to this release are less attention-grabbing straight off the bat, but not without note. For the most part they’re under the hood as opposed to standing out straight away, and



it’s likely you’ll only notice them immediately if you’re a Painter-user already. Having now introduced 64-bit support for its Windows version and tweaked some of the program’s parameters in the 32-bit Windows and Mac versions, Corel claims that the program now runs up to 40 per cent faster than previous versions. We can’t check the stats, but there’s a definite, noticeable improvement in performance compared to older versions. If you were getting frustrated with a previous version of Painter when you compared it to Photoshop CC’s overall operating speed, that’s a small but significant annoyance removed from your workflow. Corel reckons that brushes are also up to six times faster. What this means in practice is not that you’ll have to get used



AROUND THE PAINTER INTERFACE



FIND YOUR WAY AROUND THE LATEST VERSION OF COREL PAINTER AND LEARN TO MANAGE ITS TOOLS ■ BRUSHES



■ MIXER PALETTE



Painter’s brushes are the heart and soul of the program. Use the drop-down in the top-left to select from a wealth of different drawing and painting tools, including brushes that emulate classic art styles and the brand new Particle brushes.



Change the Colour palette to the Mixer view and you find a miniature artist’s mixing board. The tools below it include digital paintbrushes and palette knives, so that you can mix colour as if with real paint, for precision palette control.



■ PALETTES Painter’s powerful colour palette lets you choose colours from a complete breakdown of shades and tones. Beneath it you’ll find the Layers palette, which works in exactly the same way as Photoshop’s (although with some additional blending modes unique to Painter).



■ AUTOPAINTING Painter’s innovative Autopainting feature is found under Window>Autopainting palette>Autopainting. This allows you to choose a brush, clone a photo, and get Painter to do the painting for you. It’s perfect for creating a base layer for your work.



to a speedier, twitchier painting style, but that you won’t suffer the annoying lag that could sometimes occur when using the more complex brushes, or brush sizes over 300px, resulting in strokes that you can control with improved accuracy. Sharper, smoother and more honed, this is an excellent update to the Painter family.



VERDICT



DESIGN INSPIRATION COOLHUNTING



www.coolhunting.com



Features: 9/10 Ease of use: 7/10 Value for money: 8/10 Quality of results: 9/10



FINAL SCORE:



Painter’s Apply Lighting filter allows you to add assorted lighting effects based on a selection of presets. Here we’ve used Blue Drama to enhance the image’s blue glow



TOP 5…



8/10



The brand new brushes are the obvious draw, but it’s the speed and performance enhancements that make this version of Painter more pleasant to use than ever before.



Cool Hunting was founded way back in 2003 as a designer’s personal inspiration board. It now has a global team of editors searching out the great, the good and the cuttingedge, posted on a rolling, Tumblr-like interface.



LOST AT E MINOR



www.lostateminor.com Founded in Australia in 2005 by brothers Zolton and Zach Zavos, Lost At E Minor specialises in emerging and under-theradar trends and content across art, design, illustration, architecture and much more.



APE ON THE MOON



www.apeonthemoon.com Founded by illustrators Philip Dennis and Alex Mathers (also of creative advice hub Red Lemon Club), Ape on the Moon concentrates primarily on showing the incredible work of upcoming illustrators.



BOOOOOOOM



www.booooooom.com Founded in 2008 by Vancouver-based artist Jeff Hamada, Booooooom is one of the most popular art blogs on the web. It also has a Submit Work button, so you can get your own output in front of its vast audience.



SQUIDFACE & THE MEDDLER



www.squidfaceandthe meddler.com This online arts magazine from Canada focuses mainly on its own territory, but includes art and illustration from other parts of the world. Particularly good for high-end indie comics, it was founded by designer Michael Wandelmaier and illustrator Jessica Fortner.



QUICKFIRE EFFECTS IN PAINTER



USE SOME OF PAINTER’S TOOLS TO PRODUCE A QUICK PIECE OF CONCEPT ART WITH FIERY EFFECTS



01 SET UP THE CANVAS



02 QUICK CHEAT



03 REFINE THE AUTOPAINTING



Choose a photo featuring some fire to base your painting on, open it and select File>Quick Clone. Toggle Cmd/Ctrl+T to show the original image underneath. Grab the Tinting>Basic Round brush and hit the Clone Stamp icon by the Colour palette. Choose a large size for the brush and start painting a base layer in big, bold strokes.



Go to Layer>New Layer, then Window>Autopainting palette>Autopainting. Tick ‘Smart Stroke Painting’ and then ‘Smart Settings’. Choose the Acrylic Captured Bristle brush from the Smart Stroke brush family, and hit Play. Sit back and watch Painter create art for you!



Make a new layer, grab the Tinting>Basic round brush or the Soft Cloner and use it to refine and define edges around your image. Now grab the Spring Flame Glow brush from the Particle brushes and use it to add height and definition to the flames and a scattering of rim light on the objects nearest to the light source.
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READER INTERVIEW TALES FROM THE DARK SIDE



READER INTERVIEW



TALES FROM THE DARK SIDE



FREELANCE ARTIST DAVID PADILLA DISCUSSES HIS SIGNATURE ‘DARK’ STYLE AND WHO INSPIRED HIM TO CREATE HIS COMPLEX IMAGES



D



avid Padilla’s work presents Photoshop used to its capacity. Displaying both his raw talent and dark vision through a portfolio of complex manipulations, Padilla has successfully built up a name for himself. “I like to use many visual elements and contrasting dark tones. I usually represent scenes that are chaotic or have a colder feeling.” The surreal nature of his images comes across through all of his compositions, something which most artists find hard to demonstrate. Read on to discover how Padilla creates his this signature style.



TELL US HOW YOU GOT INTO CREATING DIGITAL ART? As a child, I used to draw anything I would see on the street or on TV. I started using paper until I realised that I would probably need different tools in order to embody any further ideas I may come up with. I was fascinated by digital drawings in magazines, so discovering Photoshop was definitely a turning point for me. WHAT DO YOU DO FOR YOU CAREER? Currently I work as a freelancer, focusing mostly on advertisements and CD covers. I feel really free doing



OUR READER DAVID PADILLA www.davidpadillablog.es @davdpadilla



One of my preferred resources to use are textures and a soft brush to lighten images. I also like playing with Levels, Curves and tones
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All article images © David Padilla



Game 2020: “I wanted to represent the games of the future in this piece. For the virtual characters I used Filter>Stylize>Find edges, and applied this layer with Screen blending mode. It was for a Hysterical Minds ‘Expression’ called Redemption.”



Inferno: “I created this image for a manipulation tutorial. I used particles with blend modes activated to make the fire. The illumination was made using a soft brush.”



Adding atmosphere: To make the atmosphere, I worked with different stock images including fire, smoke and sparks. I then applied masks to cut out areas and left all the best parts.



Rocks: Next, I added rock particles around the face. For the disintegration, I used the Smudge tool with a dispersion parameter.



Lighting: To give the idea of depth, I found rock photo stocks online and added lighting using an orange soft brush.



When I work with pictures, I pay special attention to what professional photographers do and how they set their scenes 088



TALES FROM THE DARK SIDE READER INTERVIEW



this and I think that is because of my personal style. I belong to Hysterical Minds – a community that is closely related to graphic design, where artists from all over the world meet. Everyone can learn so much from the images they produce. HOW WOULD YOU DESCRIBE YOUR INDIVIDUAL STYLE? The techniques I use are mainly associated with photomanipulation. I build scenes by combining different images, creating a composition based around the idea that I want to represent. My style is dark – it is where I feel better and where I believe my scenes are better represented. WHAT TECHNIQUES DO YOU USE TO PRODUCE SUCH COLOURFUL IMAGES? First of all I gather all of the images I’m going to use in the composition, then I focus primarily on colour and lighting. I like that my works all have an identifying look, which provides unity to my projects. One of my preferred resources to use are textures and a soft brush to lighten images. I also like playing with Levels, Curves and tones. WHICH IMAGE IS YOUR FAVOURITE AND WHY? I like the finish on ‘Death’ the most. I am passionate about colours and contrast, so I decided that I wanted something visually powerful for this one. I tried some new techniques and was very satisfied with the result, so I started to apply these ideas in other works. To have something as sinister as Death represented in full colour produced a stunning outcome. WHO WOULD YOU SAY IS YOUR INSPIRATION? ARE THERE ANY ARTISTS YOU LOVE? When I work with pictures, I pay special attention to what professional photographers do and how they set their scenes. Photographers like Dean West or Gregory Crewdson are definitely role models. As for digital art, many artists have influenced me; David Fuhrer, Valp



Death: For this image I used some objects made in cinema 4D. It was really hard to create the transparent effect and blend the skeleton. To do this I applied many layers with a screen blending mode



THEN AND NOW



SEE THE PROGRESSION OF PADILLA’S FIRST COMPOSITION TO THE MOST RECENT ARTWORK Origin is one of the first images that I created with Adobe Photoshop. At the time, I felt like it was a nice piece, although it doesn’t have final image processing. Tribute Giger is one of my most recent compositions, and I think comparing the two images shows huge progression in my work. Besides Adobe, I now use other programs for 3D modelling to make a complete composition. In my recent work, I have improved depth, light and shadow, colour and finish to build realism. Now that I have more experience, I am more careful with the details.



Origin: I wanted this piece to represent nature and the origin of life. It was one of my first composites



Maciej Hajnrich, Niklas Lundberg and Peter Jaworowski. Martin Grosh is my favourite artist, his works are inspiring. WHAT DO YOU THINK IS THE MOST USEFUL PHOTOSHOP TOOL WHEN CREATING YOUR DIGITAL ARTWORK? Every tool is important, but I love transforming images. For cutting out stock I do all my selections with the Pen or Lasso tool and for hair I use Channels. DO YOU WORK WITH STOCK PHOTOGRAPHY OR TAKE THE IMAGES YOURSELF? IF STOCK, TELL US ABOUT A TYPICAL IMAGE WORKFLOW…



Identity: For this composite, the background elements were created in CINEMA 4D. I then added the fire images and flame textures followed by extra light and textures to the mask



Tribute Giger: This image is a tribute to H.R.Giger, I wanted to present a typical alien scene, for which I used cold light filters and many different textures for the background



I do both; depending on the project, I either resort to image banks or make them up myself. I use my camera for special textures, landscapes and small details so I can have my own resources. In case I can’t do this, stocks are always available. CAN YOU GIVE ANY ADVICE TO ARTISTS JUST STARTING OUT? Firstly, I would tell them to enjoy what they do, and practise. Every new day brings you a chance to learn a bit more, but you have to be consistent. Good references, related articles and walking into art galleries can help you a lot in your growth as an artist.



Vision Of Future: To represent a vision of the future, I used green and blue colouring. On the top of the head, I used the Liquify filter and added lights using a Screen blending mode
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RESOURCE PROJECT



CREATE YOUR OW RUST TEXTURES



SPEED UP TIME BY CREATING YOUR OWN RUST TEXTURES OVERNIGHT



R



ust is one of the most useful textures. It quickly makes photos look worn and used and neglected. In this tutorial, you’ll learn how to create physical rust and then how to digitise it and use it in your design projects. But first there are a few things to note. Most importantly, rust is a chemical reaction. Chemical reactions can be dangerous. Most of the chemicals



used in this tutorial are relatively safe, but muriatic acid – a very harsh cleaner – is used, so always be careful. Now, since rust is a chemical reaction, it needs certain ingredients to work properly. The metal that you use must contain some form of iron. This is because rust is actually the effect of iron that has oxidised, so only metals with iron will work. Steel, tin and wrought iron are your best bets.



However, when buying your metal, make sure it’s not galvanised. Hardware stores galvanise their metal to prevent it from rusting, so make sure you find something like welding steel, which is not galvanised. Finally, remember that the rust you create will not eat through the metal – since it is created quickly, it will only be a thin layer on top of the metal.



CREATE YOUR OWN RUST TEXTURES FILESILO



HOW TO CREATE RUST QUICKLY



CREATE RUST USING MURIATIC ACID AND HYDROGEN PEROXIDE



01



MATERIALS



For this technique you’ll need muriatic acid and hydrogen peroxide (both of which can be bought at hardware stores), degreaser, sheets of weld-able steel or any iron-based metal that’s not galvanised, a steel brush, a paintbrush, and gloves.



02



CLEAN



Using the degreaser and a towel or rag, clean off any oil or grease that’s on the metal. This will help the rust to stick. If you don’t have degreaser then you can use soap and water.



03



BRUSH



Use the metal-bristled brush to scratch the surface of the metal. Don’t scratch evenly – it’s supposed to look like it’s been naturally worn over time. Scratch in all directions and with varying amounts of pressure.



04



ACID



Make sure that you put on gloves for this step because muriatic acid is very strong and corrosive. Then use an old paintbrush and cover the metal with the acid. Again, don’t make this too even. Then let it dry completely.



05



PEROXIDE



Once your acid is dry, pour some hydrogen peroxide on the metal and immediately you should see rust form. Then use the brush to spread the peroxide over the metal. Let it dry and you’ll have a nicely rusted effect.
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DIFFERENT RUST TECHNIQUES



SHOWS HOW DIFFERENT CHEMICALS MAKE DIFFERENT RUST EFFECTS This picture shows four different methods of rusting metal. Using common household products, there are an endless number of rust appearances that you can create.



This technique contains the most accessible ingredients, using only hydrogen peroxide and salt. It’s great for making brushes and applying as a texture.



First, brush with vinegar and then, while still wet, apply peroxide. This is a light coat of rust that has smooth lines and a great copper colour.



The most dangerous technique because of the acid, but it gives great, smooth rust results. The colour and randomness are beautiful.



This is the most time-intensive technique because it requires a half-hour soak in one part vinegar and two parts bleach. It’s nice and even, perfect for large areas.



CREATE YOUR OWN RUST TEXTURES FILESILO



SALT RUST TECHNIQUE



RUST TECHNIQUE USING HYDROGEN PEROXIDE AND SALT



01



MATERIALS



For this technique you’ll simply need hydrogen peroxide, salt of your choosing, a paintbrush, and a sheet of metal. Also make sure your metal is clean and degreased before you begin.



02



PEROXIDE APPLICATION



With your brush, paint a coat of hydrogen peroxide onto the metal. Pretty quickly, you should see rust forming, but do not let the peroxide dry before moving onto the next step.



RUSTY TEXTURES



USING DIGITAL TEXTURES TO CREATE INSTANT RUST EFFECTS



SALTING



While the peroxide is still wet on the metal, sprinkle some salt into various areas of the metal. The salt will make the rust spread in interesting ways, and it will also make the rust look grainier.



non-rusted elements. Repeat this process with multiple texture files to add rust texture across the surface. Using a rust brush on the layer mask is particularly effective. Add an empty layer for the painted rust effects. Add a Bevel & Emboss layer style with a small size, but maximum depth. Check the Contour box beneath the Bevel and Emboss style. Change the layer blending mode to Multiply and use white paint with one of the rust brush tips. This will allow the layer style to show through, but hide the actual paint pixels.



Base photo © www.freeimages.com/photo/1289287



Begin by layering a rust texture over the car. Set the blending mode to Color Burn to get that delicious, rusted-metal hue. Use the Warp transformation to make the texture flow along the same angles as the metallic surface. Then add a layer mask and mask out the hard edges or parts of the texture over



03
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FILESILO CREATE YOUR OWN RUST TEXTURES



RUST BRUSHES



HOW TO MAKE RUST BRUSHES TO APPLY AS TEXTURES



02



COLOR RANGE



Next, use the Color Range tool (Select>Color Range) to select some of the black in the picture, and change the Fuzziness until the thumbnail has just enough white to not have harsh edges.



01



03



LEVELS



First, choose a photo of rust – any photo will do as long as it has texture. Desaturate it with Image>Adjustments>Desaturate. Use a Levels adjustment to increase the contrast, and remember that whatever is black will be the brush.



RUST BRUSHES
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EDGES



Speaking of edges, now take a random, noisy brush and go around the edges of the brush with white to remove any harsh edges you still might have. Then save it as a brush with Edit>Define Brush Preset.



RUST PHOTOS



12 RUST BRUSHES



9 RUST STOCK PHOTOS



Load these beautifully grungy rust brushes to add custom grime effects to your digital designs. Open the Brush Presets panel and use the flyout menu to load the ABR file.



We’ve also provided nine high-resolution stock images of various rust effects. Everything ranging from rough grain to swirling corrosion is included. You can use these to add character and interest to surfaces.



Learn in style



The TM



Series Discover more with the Book series’ expert, accessible tutorials for photography, 3D art, Photoshop, web design and more



BUY YOUR COPY TODAY



Print edition available at www.imagineshop.co.uk Digital edition available at www.greatdigitalmags.com Available on the following platforms



facebook.com/ImagineBookazines



twitter.com/Books_Imagine



RESOURCES FILESILO



YOUR FREE RESOURCES LOG IN TO WWW.FILESILO.CO.UK/ADVANCEDPHOTOSHOP127 AND DOWNLOAD YOUR FANTASTIC PHOTOSHOP RESOURCES NOW



EVERYTHING YOU NEED TO FOLLOW ALONG WITH THE MAGAZINE AND CREATE GREAT PHOTOSHOP ART



EXCLUSIVE WALLPAPERS YOUR BONUS RESOURCES ON FILESILO THIS ISSUE, FREE AND EXCLUSIVE FOR ADVANCED PHOTOSHOP READERS, YOU’LL FIND RESOURCES WORTH $83, INCLUDING… ■ Two Typodermic fonts, Cotton and From The Internet ■ 80 frosted backgrounds from SparkleStock ■ Vintage Effects Action set by Charles Perrault ■ Six cracked-wall logo mock-ups by Gabor Monori ■ 20 high-res stock photos by Anna Mielich ■ Exclusive video tutorial from Kirk Nelson



EXPERT TUTORIALS THIS MONTH’S COMBINED RESOURCE VALUE:



$83



20 STOCK IMAGES



www.filesilo.co.uk/advancedphotoshop-127



FILESILO – THE HOME OF PRO RESOURCES DISCOVER YOUR FREE ONLINE ASSETS A rapidly growing library Updated continually with cool resources Lets you keep your downloads organised Browse and access your content from anywhere No more torn disc pages to ruin your magazines



No more broken discs Print subscribers get all the content Digital magazine owners get all the content too! Each issue’s content is free with your magazine Secure online access to your free resources This is the new FileSilo site that replaces your disc. You’ll find it by visiting the link on the following page. The first time you use FileSilo you’ll need to register. After that, you can use the email address and password you provided to log in.



The most popular downloads are shown in the carousel here, so check out what your fellow readers are enjoying! If you’re looking for a particular type of content like brushes or fonts, use the filters here to refine your search. Can’t find the resource you’re looking for in these filters? Click on More Types to specify exactly what kind of resource you want. Green open padlocks show the issues you have accessed. Red closed padlocks show the ones you need to buy or unlock. Top Downloads are listed here, so you can get an instant look at the most popular downloaded content. Check out the Highest Rated list to see the resources that other readers have voted for as the best!



Find out more about our online stores, and useful FAQs like our cookie and privacy policies and contact details.



Discover our amazing sister magazines and the wealth of content and information that they provide.
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RESOURCES FILESILO



HOW TO US



EVERYTHING YOU NEED TO KNOW ABOUT ACCESSING YOUR NEW DIGITAL REPOSITORY



To access FileSilo, please visit www.filesilo.co.uk/advancedphotoshop-127



01



Follow the instructions on-screen to create an account with our secure FileSilo system, or log in and unlock the issue by answering a simple question about the magazine. You can access the content for free with your issue.



02



If you’re a print subscriber, you can easily unlock all the content by entering your unique Subscriber ID. You can find this on all correspondence from Imagine Publishing, including the clear plastic envelopes your magazine gets delivered to your door in every month.



03



You can access FileSilo on any desktop, tablet or smartphone device using any popular browser (such as Safari, Firefox or Google Chrome). However, we recommend that you use a desktop to download content, as you may not be able to download files to your phone or tablet.



04



If you have any problems with accessing content on FileSilo, or with the registration process, take a look at the FAQs online or email filesilohelp@ imagine-publishing.co.uk.



NEED HELP WITH THE TUTORIALS? Having trouble with any of the techniques in this issue’s tutorials? Don’t know how to make the best use of your free resources? Want to have your work critiqued by those in the know? Then why not visit the Advanced Photoshop Facebook page for all your questions, concerns and qualms. There is a friendly community of fellow Photoshop users to help you out, as well as regular posts and updates from the magazine team. Like us today and start chatting!



facebook.com/AdvancedPhotoshop Issue 128 of 098



is on sale 30 Oct 2014 from GreatDigitalMags.com



A fusion of creativity Brilliant technology. Amazing art. It’s a match that helps deliver great images and videos to creative professionals like you. 40 million images 1.9 million videos 40,000 new ﬁles added daily



Explore our innovative new tools at shutterstock.com/labs.
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